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Introduction

Printing describes how to install the printer drivers on Windows and Mac OS computers for the ComColorExpress
FS2000C.

This document covers the following topics:

Installing printer drivers on Windows computers

Setting up the printing connections on Windows computers

Printing from Windows computers

Installing printer drivers on Mac OS computers

Setting up Mac OS computers for printing

Printing from Mac OS computers

ComColorExpress FS2000C print options

Using printing methods other than the printer driver to print to the ComColorExpress FS2000C

For information about setting up network servers and client computers to use the ComColorExpress FS2000C, see
Configuration and Setup. For general information about using the printer, your computer, application software, or
network, see the documentation that accompanies those products.

For information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the ComColorExpress FS2000C, printer,
and supported operating systems.

Term or convention

Refers to

Aero

FS2000C (in illustrations and examples)

Command WorkStation

Fiery Command WorkStation

Printer ComColor GD

FS2000C ComColorExpress FS2000C

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in

Configuration and Setup.
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Term or convention Refers to

n Warning: A warning concerning operations that may lead to death or injury to persons if not performed
) correctly. To use the equipment safely, always pay attention to these warnings.

2 Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
) use the equipment safely, always pay attention to these cautions.

2 Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
) equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the ComColorExpress FS2000C.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Graphic Arts Package
Premium Edition, Printing, Utilities

Online help e Help can be accessed directly from each Fiery application or by going to help.efi.com.

e Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference

material e Fiery Color Reference - help.efi.com/ref/colorref/en-us/

e Variable Data Printing - help.efi.com/ref/vdp/en-us/
o Workflow Examples - help.efi.com/ref/workflows/en-us/
e  Configure Help - help.efi.com/configure/3.0/en-us/

e Fiery Ticker Help - help.efi.com/fieryticker/2.0/en-us/

User software for printing

You need to install user software to set up basic printing on the FS2000C.

Other documents may describe user software that can be used to print documents.

User software Description

Printer drivers (for Windows and Provides information about the FS2000C and your particular printer model to your
Mac OS) application and printer driver.

Printer Delete Utility (for Windows) Uninstalls the Windows printer driver and associated printer driver files. (See

Uninstall printer drivers from Windows client computers on page 17.)

Fiery Software Uninstaller Utility (for | Uninstalls the Mac OS printer and associated printer driver files. (See Uninstall
Mac OS) printer driver from a Mac OS computer on page 34.)



http://help.efi.com
http://help.efi.com/ref/colorref/en-us
http://help.efi.com/ref/vdp/en-us
http://help.efi.com/ref/workflows/en-us
http://help.efi.com/configure/3.0/en-us
http://help.efi.com/fieryticker/2.0/en-us/
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Windows for FS2000C

The FS2000C can be set up as a printer on a Windows computer by installing the printer driver that corresponds to
your printer and setting up the FS2000C for printing.

Printer drivers provide a way to communicate information about print jobs between your applications, the FS2000C,
and the printer.

Installing Windows printer drivers

Installing the printer driver is the first step to set up the FS2000C as a printer.

The User Account Control (UAC) feature is available on computers with the Windows operating systems supported
by the FS2000C. You must be the administrator or a user with Administrator privileges to install printer drivers. For
information about supported operating systems, see Configuration and Setup.

Note: If the FS2000C printer driver is already installed, you must uninstall it before you install a new driver. (See
Uninstall printer drivers from Windows client computers on page 17.)

Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your
computer from the FS2000C with Point and Print.

You can then print to a particular connection (Print queue, Hold queue, Direct connection or the name of the virtual
printer).

If the Sequential Print queue is enabled on the FS2000C, then the sequential print connection is available.

Sequential Print allows the FS2000C to maintain the job order on certain jobs sent from the network. The workflow
is 'First In, First Out' (FIFO), respecting the order in which the jobs were received over the network. For more
information, see Command WorkStation Help.

Each connection requires a separate installation. Repeat the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable options manually. The
installed options are displayed as the FS2000C configuration in the printer driver. (See Configure installable options
on Windows client computers on page 24.)

Before you begin, ask your administrator to do the following in Setup on the FS2000C:

e Assign the FS2000C a valid IP address.

The IP address or DNS name is required in the following procedure.
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Note: Do not use the following network IP addresses, as they are reserved for communication between the
printer and the FS2000C server.

e 192.168.255.xxx
e 172.16.255.xxx
e 10.255.255.xxx

e Configure the FS2000C for SMB printing.

Note: SMB printing is referred to as Windows Printing in Setup and on the Configuration page.

For more information, see Configuration and Setup or Command WorkStation Help.

Set up SMB printing on Windows computers for the FS2000C

Install the FS2000C printer driver with SMB printing on Windows computers.

1 To navigate to computers and devices on your network, do one of the following:

¢ Windows 10: Press the Windows logo key on the keyboard to open the Start screen. From the desktop, right-
click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware and Sound and
then click Devices and Printers.

¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

¢ Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

¢ Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

2 Search for the FS2000C on the network using either its name or IP address.

If you cannot locate the FS2000C, contact your administrator.



3 Double-click the FS2000C icon to display active print connections.

Note: For a description of each print connection, see Configuration and Setup.
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4 Double-click the connection that you want to set up (print, hold, direct or the name of the virtual printer).

If the Sequential Print queue is enabled on the FS2000C, then the sequential print connection is available.

The files are installed on your computer.

Note: You may receive a message that you are about to connect to a printer on the FS2000C, which will

automatically install a printer driver on your computer. Click Yes to continue.

5 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

6 Right-click the FS2000C icon and choose Printer properties or Properties.

7 Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the FS2000C, if your

administrator has turned on access to WebTools.
For information about Setup, see Configuration and Setup.

For information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the FS2000C.

2 Click the Downloads tab.

11
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3 Click the link for the item that you want to install.

For Windows printer drivers, click the Printer Files link under the Windows heading.
4 If a dialog box prompts you to open the file or save it to disk, save it to disk.

5 Browse to the location where you want to save the PRNTDRV.EXE file and click Save.

The file is downloaded from the FS2000C. This compressed file is an archive that contains multiple files.

6 Double-click the PRNTDRV.EXE file to extract the files.
Depending on your operating system, you might be prompted to select a location to extract the files.

After the files are copied to the specified location, the Fiery Driver Installer starts automatically.

Note: The User Account Control (UAC) feature is available on computers with the Windows operating systems
supported by the FS2000C. You must be the administrator or a user with Administrator privileges to install
printer drivers. Right-click PRNTDRV.EXE and select Run as administrator. For information about supported
operating systems, see Configuration and Setup.

7 Install the printer driver.

Follow the instructions for your operating system to install the printer driver. The procedures are the same as for
installing from the DVD. (See Install and complete the print connection for Windows on page 13.)

Download printer drivers from the FS2000C

You can download the printer driver to your computer directly from the FS2000C over the network, and then follow
the instructions for your operating system to install the printer driver.

The administrator must share the PC_User_SW folder over the network before you can perform the procedure. The
procedures are the same as for installing from the User Software DVD or downloaded from WebTools.

1 To navigate to computers and devices on your network, do one of the following:

¢ Windows 10: Press the Windows logo key on the keyboard to open the Start screen. From the desktop, right-
click the Start button in the lower-left corner of the screen. Click Control Panel, click Network and Sharing
Center, and then click the View network computers and devices link from the Network and Sharing Center list.

¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel, click Network and
Sharing Center, and then click the View network computers and devices link from the Network and Sharing
Center list.

¢ Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Network and Sharing Center. Type network in the Search field to view all options. Click the
View network computers and devices link from the Network and Sharing Center list.

¢ Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

¢ Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.
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2 Search for the FS2000C on the network using either its name or IP address.

If you cannot locate your FS2000C, contact your administrator.

3 Double-click the name of the FS2000C.

A folder called PC_User_SW is displayed along with the active print connections.
4 Double-click the PC_User_SW folder and browse to the Print Drivers\Ps_drvr folder.

5 Install the printer driver.

To complete the printer driver installation, follow the procedure in Install and complete the print connection for
Windows on page 13.

Install and complete the print connection for Windows

You can install the printer driver from the User Software DVD or download and install it from WebTools.

When you install the printer driver and complete the print connection, you are automatically creating a local printer
(Port 9100). You can modify the port connection later, according to your network type.

1 To install the printer driver, do one of the following:

¢ Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse
to the Windows_User_SW\Print Drivers\Driver_Installer folder, and double-click setup.exe.

Note: When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start
automatically.

e From WebTools, after the printer driver is copied to the specified location, the Fiery Driver Installer starts
automatically.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer - InstallShield Wizard appears.
3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.
4 Read the license agreement, click | accept the terms of the license agreement and click Next.
5 For these Windows operating systems, do the following:

e Windows 10/8.1/8/Server 2012/Server 2012 R2: Click The printer that | want isn’t listed.

6 To add alocal printer on the network, do one of the following:

¢ Windows 10/8.1/8/Server 2012/Server 2012 R2: Select Add a local printer or network printer with manual
settings.

¢ Windows 7/Server 2008 R2: Select Add a local printer.

¢ Windows Vista/Server 2008: Select Add a local printer.

7 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.

Note: The WSD port is supported on Windows 7 or later.
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8 Do one of the following:

¢ Windows 10/8.1/8/Server 2012/Server 2012 R2: Type the host name or IP address of the FS2000C. Select the
Query the printer and automatically select the driver to use check box. Click Next and proceed to step 9.

e Windows 7/Vista/Server 2008/Server 2008 R2: Type the host name or IP address of the FS2000C, and then
click Next. Proceed to step 9.

9 In the Printers box, select your printer and click Next.
10 Type a name for the FS2000C in the Printer name field, and click Next.

This name is used in the Devices and Printers (or Printers and Faxes or Printers) folder and the queues window.
11 Follow the on-screen instructions.

Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at
this time.

Continue with the printer driver installation and at the last screen, click Finish.
The necessary files are installed on your hard disk drive.
12 Configure the installable options.
For more information, see Configure installable options on Windows client computers on page 24.

13 To set up a connection other than Port 9100, see Set up Standard TCP/IP Port (Raw or LPR) printing
connections on Windows client computers on page 18.

14 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:
¢ Spool print documents so program finishes printing faster
e Start printing immediately

¢ Print spooled documents first

15 Click Apply in the FS2000C Properties dialog box, and then click OK.

Install the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2008
computer

If your network users print to the FS2000C with Windows Server 2008 (32-bit) print sharing, and 64-bit Windows 7
users are also on your network, you must add the 64-bit printer driver to the Windows Server 2008 (32-bit)
computer, so that users can install the printer driver on their computers using Point and Print.

We do not recommend installing the printer driver from a server (32-bit) to client computer (64-bit). When you
install the 64-bit printer driver to the computer (32-bit), the Windows Server 2008 (64-bit) CD is required.

1 Install the FS2000C printer driver on the Windows Server 2008 computer.
For instructions, see Install and complete the print connection for Windows on page 13.
During the installation, when asked if you want to share the printer, select Yes.

2 In the Printers window, right-click the printer that you just installed and select Server Properties.

3 Click the Drivers tab, click Add and then click Next.



Printing 15
Windows for FS2000C

4 Select the x64 components check box.

5 Click Have Disk and browse to the Print Drivers\Ps_drvr folder on the User Software DVD, and select the
oemsetup.inf file.

6 If you are installing from the files you downloaded from the FS2000C using the Downloads tab in WebTools,
browse to Print Drivers\Ps_drvr, make sure that oemsetup.inf is selected and click Open.

7 Follow the on-screen instructions to complete the printer driver installation.

Install and connect to a virtual printer

A virtual printer allows you to print to the FS2000C using a predefined set of job settings.

You do not have to set print options manually. Before you can print to a virtual printer, the administrator must
create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can
install the printer driver and printer description files on your computer from the FS2000C using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver with Point and Print, you cannot configure installable options manually.
Installable options are configured automatically. The installed options are displayed in the printer driver when you
select the Two-Way Communication option.

Set up a virtual printer on Windows computer with Point and Print

Complete the installation and setup of the virtual printer on a Windows computer with Point and Print.
1 To navigate to computers and devices on your network, do one of the following:

¢ Windows 10: Press the Windows logo key on the keyboard to open the Start screen. From the desktop, right-
click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware and Sound and
then click Devices and Printers.

¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

¢ Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

¢ Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

2 Search for the FS2000C on the network using either its name or IP address.

If you cannot locate the FS2000C, contact your administrator.
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3 Double-click the FS2000C icon to display active print connections.

Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if those connections
are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

If the Sequential Print queue is enabled on the FS2000C, then the sequential print connection is available.

4 Right-click the virtual printer that you want and select Connect.

The files are installed on your computer.

5 Navigate to the devices and printers on your network.
The virtual printer is displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

You can print to a virtual printer as you would print to any other printer. Depending on how the virtual printer is
configured, you may not be able to set some print options.

If you use Command WorkStation to import a PostScript file to a virtual printer and the file already specifies the
number of copies, the setting for the number of copies in the PostScript file takes precedence over the number of
copies set in the virtual printer.

Note: When you print to a virtual printer installed with Point and Print, you must open the Printing Preferences
window and click OK before the job is printed. This applies the virtual printer settings to the job.

Turn on Two-Way Communication on Windows client computers

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the
options currently installed on the printer.

Note: The User Account Control (UAC) feature is available on computers with the Windows OS supported by
FS2000C. You must be the administrator or a user with Administrator privileges to add or change the installable
options after the printer driver is installed. (See Configure installable options on Windows client computers on page
24.) For information about supported operating systems, see Configuration and Setup.

1 Navigate to the devices and printers on your network.

¢ Windows 10: Press the Windows logo key on the keyboard to open the Start screen. From the desktop, right-
click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware and Sound and
then click Devices and Printers.

¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

e Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

¢ Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.
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Right-click the FS2000C icon and choose Printer properties or Properties.
Click the Installable Options tab.

Select the Two-Way Communication check box.

Type the FS2000C IP address or DNS name.

Select Update Fiery Driver When Opened to display the current default settings for the printer when the printer
driver is opened.

Click Update.

Note: To confirm that Two-Way Communication is turned on, click the About tab and check that the FS2000C
name and other server information are displayed.

Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

Uninstall printer drivers from Windows client computers

The Printer Delete Utility is installed and used locally to uninstall printer drivers from a Windows client computer.
You do not need to connect to the FS2000C before you use the software.

1
2
3

Select the Fiery Printer Delete Utility check box, and follow the on-screen installation instructions.
Click Start, select Programs or All Programs, and then select Fiery.

Select Printer Delete Utility.

Any FS2000C printer drivers found on your computer are listed.

Note: All printer drivers installed on your computer are listed.
*—, Printer Delete Utility _—)

Please select Printers to Delete from the Installed list
below:

[] Adobe PDF

[ Aero

[ \WAera'print
[ \\10.10.10.10 \print

["| Delete All Printer Drivers

I Delete the Selected Printers I

]

e ¥

Do one of the following:

e To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

¢ To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.



Printing
Windows for FS2000C

5 When you finish deleting printer drivers, click Exit.

Setting up Windows computers for printing

After the printer driver is installed on the Windows client computer, you need to configure the proper connection
for your networked FS2000C printer.

To print from Windows computers, you or the administrator must perform the following tasks to set up a
connection:

e Set up network servers, if any.
e Set up the FS2000C to accept print jobs from your computer.

e Configure a port on each Windows computer for the network type.

Setting up printing connections on Windows client computers

The print connections must be set up on the Windows client computers.

The FS2000C supports the following printing connections:

« SMB

e Standard TCP/IP (RAW or LPR)
e IPP or IPP over SSL

e FTP

e WSD

Set up Standard TCP/IP Port (Raw or LPR) printing connections on Windows client
computers

After you install the printer driver, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR)
connection on a Windows client computer.

To complete the Standard TCP/IP Port (Raw or LPR) connection, do the following:

e Prepare the FS2000C to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.
e Turn on LPD or Port 9100 on the FS2000C.

e Configure the computer for the TCP/IP connection.

For more information about Setup, see Command WorkStation Help.

Before you complete the following procedure, contact your administrator for the IP address assigned to the
FS2000C.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the
connection and install the printer driver in one procedure.

18
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Note: You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an
add-on Windows component. For more information, see the documentation that accompanies Windows.

1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the FS2000C icon and choose Printer properties or Properties.
3 Click the Ports tab.

s _
o= Aero Properties

| General | Sharing | Parts |Ad\ranced Calor Management I Security I Installable Options I About |

v

w Aero

Print to the following port(s). Documents will print to the first free
checked port.

Port Description Printer i
LPT1: Printer Port Aero

[ LPT2: Printer Port T
] LPT=: Printer Port =
[] CcomM1:  Serial Port

[] COM2:  Serial Port

[] COM3:  Serial Port

[] comd:  Serial Port =

[ Add Port... ] [ Delete Port l ’ Configure Port...

Enable bidirectional support

[T Enable printer pooling

[ OK ] [ Cancel Fpply

Help

e

4 To add a new port, click Add Port.

To change the port settings, proceed to step 10.
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5 In the Printer Ports dialog box specify the port type, do one of the following:

¢ Select Standard TCP/IP Port from the list of Available port types and click New Port.
¢ Double-click Standard TCP/IP Port in the list.

r- K
Printer Parts ﬁ

Available port types:

Adobe PDF Port Monitor
Local Port

Microsoft Decument Imaging Writer Monitor
Standard TCP/IP Port

[ MNew Port... l’ Cancel ]

L ’

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next.
7 Type the FS2000C IP address.

4 B
Add 5tandard TCP/IP Printer Port Wizard
Add port \L
For which device do you wart to add a port? N
k,_.-—':'—"—-

Enter the Printer Name or IP address, and a port name for the desired device.

Printer Mame or IP Address: |

Port Mame:

<Back | Ned> | | Cancel

X — — y

8 Click Next.

9 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer
Ports dialog box.

To change the default setting, proceed to step 10.

If you do not want to change the default setting, the setting is now completed.

Note: Port 9100 was set as the default setting in Install and complete the print connection for Windows on page
13.

20
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10 Click Configure Port on the Ports tab of the Properties dialog box.

Configure Standard TCP/IP Port Monitor &J
Port Settings

Port Mame: 1P 10101010

Printer Mame or IP Address: 1P_101010.10

Protocol

@ Raw I LPR

Raw Settings
Port Number: 9100

LPR Settings

LPR Byte Counting Enabled

SNMP Status Enabled

Community Mame: public

SMMP Device Index: 1

[ ok || Cancel

o

11 To set up the port settings, do one of the following:
¢ To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR Settings area.

Note: You can also proceed without selecting LPR Byte Counting Enabled.
¢ To use Port 9100 printing, select Raw in the Protocol area.

The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You
can print to the printer connection selected for Port 9100 printing on the FS2000C.

To specify a specific port number, see step 12.
12 Type the name of the print connection.
For LPR, type print, hold, direct or sequential for Queue Name or published virtual printer name.
For Port 9100, type the following port numbers for each print connection in the Raw Settings area:
e FS2000C default: 9100
e direct: 9101
e print: 9102
e hold: 9103

Note: Type the number exactly as shown.

13 When the SNMP Status Enabled check box is selected, spooling is stopped if the printer driver or spooler detects
an error status on the FS2000C.
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14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Note: The FS2000C supports printing in the IPv6 environment on Windows operating systems. For information
about supported operating systems, see Configuration and Setup.

15 Click Apply in the FS2000C Properties dialog box, and then click OK.

Complete IPP connections on Windows client computers

With Internet Printing Protocol (IPP), print jobs are sent to the FS2000C over the Internet from Windows
computers.

Before you begin, perform the following tasks:

o Make sure that the FS2000C is configured for TCP/IP printing and IPP printing. (See Command WorkStation
Help.)

o Specify the printing destination on your computer.

IPP over SSL connections is supported.

Note: Using IPP over SSL connection requires certificates on Windows operating systems. For information about
supported operating systems and on certificate creation, see Configuration and Setup. You can manage certificates
from Configure. (See Command WorkStation Help.)

1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 To add a printer, do one of the following:
¢ Click Add a printer, and then select Add a network, wireless, or Bluetooth printer or Add a network printer.
¢ Double-click the Add Printer icon, click Next, and then select Network printer and click Next.

3 To search for a printer on the network, do one of the following:

¢ Windows 10: If the printer search takes a long time, click The printer that | wantisn't listed.

¢ Windows 8.1/8/7/Server 2008 R2/Server 2012/Server 2012 R2: If the printer search takes a long time, click
Stop, and then click The printer that | want isn't listed.

¢ Windows Vista: Select Connect to a printer on the Internet or your intranet.
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To connect to a printer on the network, do one of the following:

¢ Windows 10: Click Select a shared printer by name, and in the URL field, type the IP address or DNS name of
the FS2000C, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2000C.

Note: The URL for the printer is not case-sensitive.

e Windows 8.1/8/7/Server 2008 R2/ Server 2012/Server 2012 R2: Click Select a Shared printer by name, and in
the URL field, type the IP address or DNS name of the FS2000C, followed by the name of the connection
(print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2000C.

Note: The URL for the printer is not case-sensitive.

¢ Windows Vista: In the URL field, type the IP address or DNS name of the FS2000C, followed by ipp/ and then
the name of the connection (hold, direct, print, or name of virtual printer).

For example, http://10.10.10.150/ipp/print, http://DNS name of the server/ipp/print or ipp://10.10.10.150
sends the job to the Print queue on the FS2000C.

For IPP over SSL, type https, instead of http.

Note: The ipp/print in the example is case-sensitive.
Click Next.
To install the printer driver, do one of the following:

¢ Windows 10: Select the manufacturer and model of your printer and click OK.

e Windows 8.1/8/7/Server 2008 R2/Server 2012/Server 2012 R2: Click Install driver.

e Windows Vista: Click OK.

If you are installing the PostScript printer for the first time, follow the procedure Install and complete the print
connection for Windows on page 13.

Indicate whether you want to make the FS2000C the default printer.
¢ Windows 10: Click Finish.
¢ Windows 8.1/8/7/Server 2008 R2/Server 2012/Server 2012 R2: Click Next.

e Windows Vista: Click Next.

To complete the printer driver installation, click Finish.
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Configure installable options on Windows client computers

After you complete the printer driver installation, you must configure the FS2000C for the options installed on the
printer to allow the FS2000C to take advantage of the printer options.

Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to
configure the options automatically.

Note: When you configure installable options manually, make sure to leave Two-Way Communication and Update
Fiery Driver When Opened options unchecked.

For information about specifying installable options, see printer driver help.

Note: The User Account Control (UAC) feature is available on computers with the Windows operating systems
supported by the FS2000C. You must log on with Administrator privileges to add or change the installable options
after the printer driver is installed. For more information about supported operating systems, see Configuration and
Setup.

1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 For Windows computers with User Account Control, right-click the FS2000C icon, select Run as administrator,
and then select Printer properties or Properties.

The User Account Control dialog box opens.
Select the User that has administrator privileges, type the password, and then click OK.
Right-click the FS2000C icon and choose Printer properties or Properties.

Click the Installable Options tab and make your selections.

A unn A~ W

Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

Configure installable options for printer drivers installed with the Add Printer Wizard on Windows
client computers
After you install the printer driver, you must configure the installable options.

If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the
installable options, the installable options are not configured properly.

1 After you install the printer driver, right-click the FS2000C icon, select Printer properties, click the Installable
Options tab, and then select your installable options.

2 Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.
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Printing from Windows client computers

You can print to the FS2000C just as you would print to any other printer from a Windows application.

You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the
FS2000C as the current printer in the Printer Name list, specify print options, and then print the document from the
application.

The following list includes other methods to print to the FS2000C and describes where to find information about
these features:

e Downloading files to the FS2000C with the Docs tab in WebTools. (See Utilities.)

Printing documents with E-mail Services. (See E-mail Service on page 60.)

e Printing documents with Hot Folders. (See Fiery Hot Folders Help.)

e Printing documents with Command WorkStation. (See Utilities.)

e DPrinting with Windows servers connected to the FS2000C. (See Configuration and Setup.)

e DPrinting documents on the USB flash drive to the FS2000C. (See Printing from a USB flash drive on page 62.)
e DPrinting documents with PrintMe cloud printing. (See PrintMe cloud printing on page 69.)

o Printing documents with Web Services Device (WSD) printing. (See Web Services for Devices printing on page
72.)

The following list includes information about printing and saving files to the FS2000C and describes where to find
information about these features:

e Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)
e DPrinting jobs from Windows applications. (See Print jobs from Windows applications on page 25.)

o Specifying default print options. (See Specify default print options for print jobs on Windows client computers
on page 28.)

¢ Customizing the Quick Access icon. (See Customize the Quick Access icon in the Windows printer driver on
page 30.)

e Viewing the printer status. (See View the printer status on page 30.)

o Saving files to print to a remote location. (See Saving files to print at a remote location on page 31.)

Print jobs from Windows applications
To print from Windows applications, install the PostScript printer driver, and then specify print options for a
particular job before sending it to the FS2000C for printing.

Be sure to configure the options on the Advanced tab of the printer driver after installation is complete. (See
Installing Windows printer drivers on page 9.)

If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer
is configured.

Some print options that are selectable from an application are similar to print options that are specific to the
FS2000C and the printer. In these cases, use the print options specific to the FS2000C and the printer. These options
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appear on the Fiery Printing tab. The application may not set up the file properly for printing on the FS2000C,
resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.

Some print options, such as expert color settings, Paper Catalog, and VDP master information, are available only if
Two-Way Communication is turned on or a particular installable option is configured. For information about Two-
Way Communication, see printer driver help. (See Configure installable options on Windows client computers on
page 24.)

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See
Print options and default settings on page 75.)

Set print options for a specific print job with the Windows printer driver

After you install the Windows printer driver on the client computer, you can set print options for a print job.
1 In your application, select File > Print, and select the FS2000C as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.
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1 Print option icons
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Printer Status

Presets (Job Templates), see Help
Customize (Shortcuts), see Help
Job View

Help
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The Fiery Printing tab serves as the control center for all frequently used printing functions.

When you save the print options in a preset, the following option settings are not reflected:

¢ Job Info options: Destination > Destination and Schedule printing, Job notes > Secure print, User
authentication > Password

e Layout option: Impose
For information about using presets, see printer driver help.
Note: For a list of print options, see Print options and default settings on page 75.

4 Specify print options and settings for your job.
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The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
print option can be added or removed from the view. The Quick Access tab lets you find print options quickly
without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon in the Windows
printer driver on page 30.)

Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 75.)

Media- Attributes and sources of paper to print and insert. (See Media options on page 79.)

Layout- Defines the imposition of the print job and the booklet process on the media/sheet, except for

positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
81.)

Color- Color settings and additional features (when turned on). (See Color options on page 92.)

Image- All Image Quality settings supported by the connected FS2000C and printer. (See Image options on
page 99.)

Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in FS2000C Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 101.)

VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Variable
Data Printing (VDP) options on page 107.)

Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 109 or printer driver help.)

Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 30 or printer driver help.)

5 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Specify default print options for print jobs on Windows client computers

You can set the default print options for Windows print jobs using the Windows printer driver.

1 Navigate to the devices and printers on your network.

Windows 10: Press the Windows button on the keyboard to open the Start screen. From the desktop, right-
click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware and Sound and
then click Devices and Printers.

Windows 8.1/Server 2012 R2: Press the Windows button on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.
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¢ Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

¢ Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

¢ Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.
2 Right-click the FS2000C icon and select Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.
(3? @ ®

-
= Aero Printing Preferences &

Fiery Printing | PastSeript ] About |

7 qi E Printer Status Idie Presets:l 2

JobInfo Media | t lor Image Finishing VDP Stamping  Printer
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Copies: @ Duplex
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1 Print option icons
Active area

Printer Status

Customize (Shortcuts), see Help

2
3
4 Presets (Job Templates), see Help
5
6 Job View

7

Help

4 Specify the default settings for your print job. (See Set print options for a specific print job with the Windows
printer driver on page 26.)
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5 Click OK to close the dialog box.

Customize the Quick Access icon in the Windows printer driver

The Quick Access icon can be customized with print options that you use frequently.

This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the FS2000C as your printer.
2 Click Properties.

Click the Fiery Printing tab.

H W

Click Customize to specify the options shown in the Customize Quick Access dialog box.

5 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

6 Click OK to save your changes.

For more information about Quick Access, see printer driver help.

Fiery Driver Updater

The Fiery Driver Updater notification is displayed by the default setting. When updates are available, the Fiery Driver
Updater notification window opens. You can update the printer driver by clicking the Update button.

You can also start the Fiery Driver Updater by clicking Check for driver update on the About tab of the Printer
Properties window.

If you prefer to have automatic notification for updates turned off, do the following procedure.
1 Start the Fiery Driver Updater.

2 Click the settings icon at the bottom left corner of the Fiery Driver Updater window.

3 Clear the Show notifications option in the Preferences window.

Note: The Fiery Driver Updater updates the Fiery core driver only.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the FS2000C and display them in
the printer driver with the Two-Way Communication option.

You can retrieve its color settings from the FS2000C and display them in the printer driver.

For information about monitoring the status of the printer, see printer driver help.
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Saving files to print at a remote location
If you do not have an FS2000C on site and are preparing files for a service bureau or other location, print the final
files to the File port (as opposed to one of the local ports).

You can also print to the File port to create a file to download using the Docs tab in WebTools. For instructions on
printing to the File port, see the documentation that accompanies Windows.



Printing 32
Mac OS for FS2000C

Mac OS for FS2000C

The FS2000C can be set up as a printer on a Mac OS computer by installing the printer driver that correspond to
your printer and setting up the FS2000C for printing.

Printer drivers provide a way to communicate information about print jobs between your applications, the FS2000C,
and the printer.

Installing printer driver on a Mac OS computer

Installing the printer driver is the first step to set up the FS2000C as a printer.

Note: If the FS2000C printer driver is already installed, you must uninstall it before you install a new driver. (See
Uninstall printer driver from a Mac OS computer on page 34.)

Install Mac OS printer driver from the User Software DVD

The User Software DVD provides the software for Mac OS computers, such as the printer driver.

1
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Quit all open applications.

Insert the User Software DVD into the DVD drive.
Open the Mac_User_SW folder.

Double-click Fiery Printer Driver.dmg.

Double-click Fiery Printer Driver.pkg and click Continue.
Read the license and click Continue.

Follow the on-screen instructions.

The Fiery Printer Driver Installer installs the printer driver that correspond to the FS2000C.

Note: When the printer driver is added with the Bonjour connection, the last three bytes of the Mac OS address
is added to the FS2000C name.

If you can find the FS2000C from the list of printers by Network Discovery, do one of the following:

¢ Select the FS2000C, and continue to install the printer driver by specifying the Print queue. The printer uses
the Bonjour connection.

¢ If you specify the Hold queue, the printer uses the LPD (LPR) protocol.
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9 Ifyou cannot find the FS2000C (on a different subnet) and you want to use Port9100/LPR/ipp or want to connect

to a virtual printer, then click Install Printer Driver Only.
You need to associate the printer driver from System Preferences > Printers & Scanners with the FS2000C.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the FS2000C, if your
administrator has configured access to WebTools.

For more information about setting up and starting WebTools, see Utilities.

1
2
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Start your Internet or intranet browser and type the DNS name or IP address of the FS2000C.
Click the Downloads tab.

Click the Printer Files link for Mac OS X.

A file named Fiery Printer Driver.dmg is downloaded to your desktop.

Note: If the file is not on the desktop, open the Downloads folder.

Double-click Fiery Printer Driver.dmg.

Double-click Fiery Printer Driver.pkg and click Continue.

Read the license and click Continue.

Follow the on-screen instructions.

Download Mac OS printer driver from the FS2000C

You can download the printer driver to your Mac OS computer directly from the FS2000C over the network.

1
2

In the Finder, select Go > Connect to Server.

Type SMB:// followed by the name or IP address of the FS2000C and click Connect.

If you cannot locate your FS2000C, contact your administrator.

Type the user name and password in the SMB/CIFS File System Authentication dialog box.

The “Guest” account can be used as the default. The Guest account does not require a password. If the Guest
account cannot be used, ask your network administrator for an account.

Select the Mac_User_SW folder from the shared volume list and click OK.
Double-click the Fiery Printer Driver Installer icon to start installing the printer driver.

Follow the on-screen instructions.
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Uninstall printer driver from a Mac OS computer

The Fiery Software Uninstaller utility is used to remove printer drivers from the Mac OS computer. It is installed and
used locally on your Mac OS computer.

Install and use the Fiery Software Uninstaller utility

1 To copy the Fiery Software Uninstaller.dmg to your desktop, do one of the following:
e Copy it from the User Software DVD.
¢ Copy it from the Mac_User_SW folder from the shared volume list on the FS2000C.

2 Double-click Fiery Software Uninstaller.dmg.

The Fiery Software Uninstaller opens in the Finder, displaying the Fiery Software Uninstaller icon and an arrow
pointing to a link to the Applications folder.

Drag the Fiery Software Uninstaller icon to the Applications folder.
Open the Applications folder and double-click the Fiery Software Uninstaller icon.
Click the Printers tab if it is not already selected.

Select a printer from the Installed Printers list.

N & u h~ W

Do one of the following:

¢ Click Remove Printer and Driver to remove the printer along with its printer driver files.

If you want to remove the printer and the associated printer driver files, you can select only one printer at a
time.

¢ Click Remove Printer to remove the printer from the Installed Printers list only, but leave the printer driver files
installed.

The utility can remove only printers that are not currently in use or open on the Dock.

Note: If more than one printer uses the same printer driver file, removing the printer driver file also removes all
printers using that printer driver.

8 To confirm that you want to delete the printer, type the password for your Mac OS computer in the dialog box
and click OK.

9 Click the Drivers tab to view the installed printer drivers.

10 Close the Fiery Software Uninstaller dialog box.

Delete the Fiery Software Uninstaller utility

» Delete the Fiery Software Uninstaller icon from the Applications folder.
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Set up Mac OS computers for printing

After the printer driver that corresponds to your printer has been installed, you must set up the Mac OS computer
for printing to the FS2000C.

Set up printing on a Mac OS X v10.11 client computer

After you have the FS2000C printer driver installed, you must set up printing to the FS2000C on a client computer
running Mac OS X v10.11. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2000C from the Print dialog box on a Mac OS X v10.11 client computer

1 Open a file in your application.
2 Select File > Print.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection.

Set up the FS2000C with Printers & Scanners on a Mac OS X v10.11 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.

In the dialog box that appears, select one of the printer connections:

e Default

e |P Printer
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Add a printer with the Default connection on a Mac OS X v10.11 client computer

You can add a printer with the Default connection on a Mac OS X v10.11 client computer.

1 Click the Default icon in the Add dialog box.

Name: No Selection
Location: Mo Selection

Use:
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Default | Fax IP Windows Search
Mame & Kind
Aero_Print Bonjour
Agro_Print.DEMO FILES Bonjour

Add

The names of printers with default connections are listed.

The names of the virtual printers appear as printer name : virtual printer name in the list of printers.

Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.11.

2 Select the FS2000C from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer

driver for the FS2000C is automatically selected.

3 Click Add.

The FS2000C name appears in the list of printers.

4 Select FS2000C.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.
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Obtain the IP address of the F$2000C on a Mac OS X v10.11 client computer

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X v10.11 client computer, you
can find out the IP address of the FS2000C from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.
2 Select the FS2000C from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.
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Scroll to Network Protocol Setup, locate the IP address for the FS2000C, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
6 Click the Close button to exit WebTools.
7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Obtain the IP address of the FS2000C

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X client computer, you can find
out the IP address from the FS2000C control panel.

1 From the FS2000C control panel, press the Menu button.

1 Activity light

2
3
4
5
6
7
8
9

Up button

Menu button

Down button

Display window

Line selection button #1
Line selection button #2
Line selection button #3

Line selection button #4
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2 DPress the second button on the right side corresponding to IP address.

The IP address of the FS2000C appears.

Add a printer with the IP Printer connection on a Mac OS X v10.11 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.11 client computer.

1
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Click the IP icon in the Add dialog box.

eo0e Add
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Default Fax IP | Windows Search

Address:
Enter host name or IP address.
Protocol: | Line Printer Daemaon - LPD =
Queue:

Leave blank for default gueue.

Name: No Selection
Location: No Selection

Use:

Add

Do one of the following:

¢ For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2000C IP address or DNS
name in the Address field, and then type the print connection (print, hold or sequential) or published virtual
printer name in the Queue field.

e For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2000C IP address or DNS
name in the Address field. The Queue field can be left empty.

Choose Select Software from the Use menu.
Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

Click Add.

Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.

The FS2000C with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver help.



Printing 39
Mac OS for FS2000C

Set up printing on a Mac OS X v10.10 client computer

After you have the FS2000C printer driver installed, you must set up printing to the FS2000C on a client computer
running Mac OS X v10.10. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2000C from the Print dialog box on a Mac OS X v10.10 client computer

1 Open a file in your application.
2 Select File > Print.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection.

Set up the FS2000C with Printers & Scanners on a Mac OS X v10.10 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.

In the dialog box that appears, select one of the printer connections:

¢ Default

e |P Printer
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Add a printer with the Default connection on a Mac OS X v10.10 client computer

You can add a printer with the Default connection on a Mac OS X v10.10 client computer.

1 Click the Default icon in the Add dialog box.

Name: No Selection
Location: Mo Selection

Use:
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Aero_Print Bonjour
Agro_Print.DEMO FILES Bonjour

Add

The names of printers with default connections are listed.

The names of the virtual printers appear as printer name : virtual printer name in the list of printers.

Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.10.

2 Select the FS2000C from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer

driver for the FS2000C is automatically selected.

3 Click Add.

The FS2000C name appears in the list of printers.

4 Select FS2000C.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.
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Obtain the IP address of the F$2000C on a Mac OS X v10.10 client computer

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X v10.10 client computer, you
can find out the IP address of the FS2000C from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.
2 Select the FS2000C from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.
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Scroll to Network Protocol Setup, locate the IP address for the FS2000C, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
6 Click the Close button to exit WebTools.
7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Obtain the IP address of the FS2000C

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X client computer, you can find
out the IP address from the FS2000C control panel.

1 From the FS2000C control panel, press the Menu button.

1 Activity light

2
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4
5
6
7
8
9

Up button

Menu button

Down button

Display window

Line selection button #1
Line selection button #2
Line selection button #3

Line selection button #4
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2 DPress the second button on the right side corresponding to IP address.

The IP address of the FS2000C appears.

Add a printer with the IP Printer connection on a Mac OS X v10.10 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.10 client computer.

1

H W

V)]

Click the IP icon in the Add dialog box.

eo0e Add
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Default Fax IP | Windows Search

Address:
Enter host name or IP address.
Protocol: | Line Printer Daemaon - LPD =
Queue:

Leave blank for default gueue.

Name: No Selection
Location: No Selection

Use:

Add

Do one of the following:

¢ For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2000C IP address or DNS
name in the Address field, and then type the print connection (print, hold or sequential) or published virtual
printer name in the Queue field.

e For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2000C IP address or DNS
name in the Address field. The Queue field can be left empty.

Choose Select Software from the Use menu.
Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

Click Add.

Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.

The FS2000C with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver help.
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Set up printing on a Mac OS X v10.9 client computer

After you have the FS2000C printer driver installed, you must set up printing to the FS2000C on a client computer
running Mac OS X v10.9. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2000C from the Print dialog box on a Mac OS X v10.9 client computer

1 Open a file in your application.
2 Select File > Print.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection.

Set up the FS2000C with Printers & Scanners on a Mac OS X v10.9 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.

In the dialog box that appears, select one of the printer connections:

¢ Default

e |P Printer
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Add a printer with the Default connection on a Mac OS X v10.9 client computer

You can add a printer with the Default connection on a Mac OS X v10.9 client computer.

1 Click the Default icon in the Add dialog box.

Name: No Selection
Location: Mo Selection

Use:
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Aero_Print Bonjour
Agro_Print.DEMO FILES Bonjour

Add

The names of printers with default connections are listed.

The names of the virtual printers appear as printer name : virtual printer name in the list of printers.

Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.9.

2 Select the FS2000C from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer

driver for the FS2000C is automatically selected.

3 Click Add.

The FS2000C name appears in the list of printers.

4 Select FS2000C.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.
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Obtain the IP address of the F$2000C on a Mac OS X v10.9 client computer

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X v10.9 client computer, you can
find out the IP address of the FS2000C from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Printers & Scanners.
2 Select the FS2000C from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.
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Scroll to Network Protocol Setup, locate the IP address for the FS2000C, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
6 Click File > Close Window to close WebTools.
7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Obtain the IP address of the FS2000C

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X client computer, you can find
out the IP address from the FS2000C control panel.

1 From the FS2000C control panel, press the Menu button.

1 Activity light

2
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8
9

Up button

Menu button

Down button

Display window

Line selection button #1
Line selection button #2
Line selection button #3
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2 DPress the second button on the right side corresponding to IP address.

The IP address of the FS2000C appears.

Add a printer with the IP Printer connection on a Mac OS X v10.9 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.9 client computer.
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Click the IP icon in the Add dialog box.
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Default Fax IP | Windows Search

Address:
Enter host name or IP address.
Protocol: | Line Printer Daemaon - LPD =
Queue:

Leave blank for default gueue.

Name: No Selection
Location: No Selection

Use:

Add

Do one of the following:

¢ For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2000C IP address or DNS
name in the Address field, and then type the print connection (print, hold or sequential) or published virtual
printer name in the Queue field.

e For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2000C IP address or DNS
name in the Address field. The Queue field can be left empty.

Choose Select Software from the Use menu.
Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

Click Add.

Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.

The FS2000C with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver help.
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Set up printing on a Mac OS X v10.8 client computer

After you have the FS2000C printer driver installed, you must set up printing to the FS2000C on a client computer
running Mac OS X v10.8. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2000C from the Print dialog box on a Mac OS X v10.8 client computer

1 Open a file in your application.
2 Select File > Print.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection.

Set up the FS2000C with Print & Scan on a Mac OS X v10.8 client computer

1 Select Apple menu > System Preferences, and then select Print & Scan.

2 Click the + button to add a printer.

In the dialog box that appears, select one of the printer connections:

¢ Default

e |P Printer
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Add a printer with the Default connection on a Mac OS X v10.8 client computer

You can add a printer with the Default connection on a Mac OS X v10.8 client computer.

1 Click the Default icon in the Add dialog box.

Name: No Selection
Location: Mo Selection

Use:
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Mame & Kind
Aero_Print Bonjour
Agro_Print.DEMO FILES Bonjour

Add

The names of printers with default connections are listed.

The names of the virtual printers appear as printer name : virtual printer name in the list of printers.

Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.8.

2 Select the FS2000C from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer

driver for the FS2000C is automatically selected.

3 Click Add.

The FS2000C name appears in the list of printers.

4 Select FS2000C.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.
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Obtain the IP address of the F$2000C on a Mac OS X v10.8 client computer

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X v10.8 client computer, you can
find out the IP address of the FS2000C from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Print & Scan.
2 Select the FS2000C from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.
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Scroll to Network Protocol Setup, locate the IP address for the FS2000C, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
6 Click File > Close Window to close WebTools.
7 Click OK to close the Options & Supplies pane.
8 Close the Print & Scan dialog box.

Obtain the IP address of the FS2000C

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X client computer, you can find
out the IP address from the FS2000C control panel.

1 From the FS2000C control panel, press the Menu button.

1 Activity light
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Up button

Menu button

Down button
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Line selection button #1
Line selection button #2
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2 DPress the second button on the right side corresponding to IP address.

The IP address of the FS2000C appears.

Add a printer with the IP Printer connection on a Mac OS X v10.8 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.8 client computer.
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Click the IP icon in the Add dialog box.
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Default Fax IP | Windows Search

Address:
Enter host name or IP address.
Protocol: | Line Printer Daemaon - LPD =
Queue:

Leave blank for default gueue.

Name: No Selection
Location: No Selection

Use:

Add

Do one of the following:

¢ For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2000C IP address or DNS
name in the Address field, and then type the print connection (print, hold or sequential) or published virtual
printer name in the Queue field.

e For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2000C IP address or DNS
name in the Address field. The Queue field can be left empty.

Choose Select Printer Software from the Use menu.
Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

Click Add.

Specify the installable option settings in the installable options pane in the Print & Scan dialog box, and then click
OK.

The FS2000C with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver help.
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Set up printing on a Mac OS X v10.7 client computer

After you have the FS2000C printer driver installed, you must set up printing to the FS2000C on a client computer
running Mac OS X v10.7. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2000C from the Print dialog box on a Mac OS X v10.7 client computer

1 Open a file in your application.
2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the FS2000C with Print & Scan on a Mac OS X v10.7 client computer

1 Select Apple menu > System Preferences, and then select Print & Scan.

2 Click the + button to add a printer.

In the dialog box that appears, select one of the printer connections:

e Default

e |P Printer
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Add a printer with the Default connection on a Mac OS X v10.7 client computer

You can add a printer with the Default connection on a Mac OS X v10.7 client computer.

1 Click the Default icon in the Add Printer dialog box.

&) 0 Add Printer
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Name: &
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Print Using:

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.
Note: SMB printing is not supported for Mac OS X v10.7.
2 Select the FS2000C from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the FS2000C is automatically selected.

3 Click Add.
The FS2000C name appears in the list of printers.

4 Select FS2000C.
5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.
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Obtain the IP address of the F$2000C on a Mac OS X v10.7 client computer

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X v10.7 client computer, you can
find out the IP address of the FS2000C from the printer’s Webpage.

1 Select Apple menu > System Preferences, and then select Print & Scan.
2 Select the FS2000C from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.
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Scroll to Network Protocol Setup, locate the IP address for the FS2000C, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
6 Click File > Close Window to close WebTools.
7 Click OK to close the Options & Supplies pane.
8 Close the Print & Scan dialog box.

Obtain the IP address of the FS2000C

When the Bonjour connection is used for the FS2000C printer driver on a Mac OS X client computer, you can find
out the IP address from the FS2000C control panel.

1 From the FS2000C control panel, press the Menu button.

1 Activity light
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Up button

Menu button

Down button
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Line selection button #1
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Line selection button #4



2 DPress the second button on the right side corresponding to IP address.

The IP address of the FS2000C appears.
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Add a printer with the IP Printer connection on a Mac OS X v10.7 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.7 client computer.
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Click the IP icon in the dialog box.

eoo Add Printer
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Protocol: | Line Printer Daemaon - LPD

Address:

Enter host name or IP address.

Queue:

Leave blank for default gueue.

Name: No Selection
Location: No Selection

Print Using:

Add

Do one of the following:
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¢ For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2000C IP address or DNS

name in the Address field, and then type the print connection (print, hold or sequential) or published virtual

printer name in the Queue field.

¢ For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2000C IP address or DNS
name in the Address field. The Queue field can be left empty.

Choose Select Printer Software from the Print Using menu.

Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

Click Add.
Click OK.

The FS2000C with its IP address appears in the list of printers.

Select FS2000C.

Click Options & Supplies, and then click the Driver tab.
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9 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.

Configuring installable options on Mac OS client computers

To use the print options for the printer and FS2000C appropriately, you must configure the FS2000C from your
computer for the options that are installed on the printer. Configure the options manually.

For information about configuring installable options, see printer driver help.

Using Desktop Printer
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After adding the FS2000C to the list of printers in the Printers & Scanners (or Print & Scan) dialog box, you can create

and use the Desktop Printer feature.

For information about the Desktop Printer feature, see printer driver help.

Printing from Mac OS client computers

You can print to the FS2000C just as you would print to any other printer from a Mac OS application.

Select the FS2000C as the default printer in the list of printers, specify print options, and then print the document
from the application.

The following list includes other methods to print to the FS2000C and describes where to find information about
these features:

o Downloading files to the FS2000C with the Docs tab in WebTools. (See Utilities.)

Printing documents with Hot Folders. (See Fiery Hot Folders Help.)
e Printing documents with Command WorkStation. (See Utilities.)
e Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

o Selecting the FS2000C in the Printers list. (See Select the FS2000C as the default printer on a Mac OS client
computer on page 56.)

e Printing jobs from Mac OS applications. (See Set print options and printing from Mac OS applications on page
56.)

e Customizing the Quick Access view. (See Customize the Quick Access pane in the Mac OS printer driver on page

58.)

o Viewing the printer status. (See View the printer status on page 59.)
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Select the FS2000C as the default printer on a Mac OS client computer

Before you print a job, you must set the FS2000C in the Printers list as your default printer.
1 Make sure that the FS2000C is connected to the network and turned on.
2 Select Apple menu > System Preferences, and then select Printers & Scanners (or Print & Scan).

The printers that are set up for printing are listed. The virtual printers that are configured at the FS2000C and set
up for printing are also listed.

3 Select FS2000C from the Default Printer menu.

4 Close the window.

View queries in the Print Queue on client computers

When the printer driver establishes communication with the FS2000C on a Mac OS client computer, the queries are
listed as jobs in the Print Queue.

To view the queries, open the Print Queue.

» Select Apple menu > System Preferences > Print & Scanners (or Print & Scan), then select the FS2000C from the
list of printers, and click Open Print Queue.

The queries are not real jobs and they will disappear from the Print Queue after they are completed.

Set print options and printing from Mac OS applications

To print from Mac OS client computers, install the printer driver that corresponds to your printer.

In Mac OS applications, print options are set from the Print dialog box. (See Installing printer driver on a Mac OS
computer on page 32.)

Some print options that are selectable from an application are similar to print options that are specific to the
FS2000C and the printer. In these cases, use the print options specific to the FS2000C and the printer. These options
appear in the Fiery Features pane and/or in the Printing Preferences window. The application may not set up the file
properly for printing on the FS2000C, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.

Some print options are available only if Two-Way Communication is turned on or a particular installable option is
configured.

You can retrieve its expert color settings from the FS2000C when Two-Way Communication is turned on and
display them in the printer driver.

For information about Two-Way Communication, see printer driver help. (See Configuring installable options on
Mac OS client computers on page 55.)

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See
Set print options and print a job from a Mac OS X client computer on page 57.)



Set print options and print a job from a Mac OS X client computer

Printing
Mac OS for FS2000C

You use the printer driver to specify print options for a particular job and then print it to the FS2000C.

1 Inyour application, select File > Print, and select the FS2000C as your printer.

2 Select Fiery Features from the drop-down list.

@ @ @

Print
Printer: .rAero I-s-] E]
Presets: | Standard -+
[ B [
| Fiery Features >
Quick Access . Customize... |
Duplex:
A [of H
@ i Full Properties... | | Defaults |
®77':‘ Two Way Communication
Printer Address 10.11.32.73 Configur
Printer Name Agro
& ( v ) [ Preview | [ Supplies... ) [ Cancel | int
() ( poF (P ) ( Suppl ) ( Cancel )  Print )

1 Fiery Features

2 Customize (Shortcuts), see Help
3 Full Properties

4 Presets (Job Templates), see Help
5

Two-Way Communication

When you save the print options in a preset, the following option settings are not reflected:

¢ Job Info options: Destination > Destination and Schedule printing, Job notes > Secure print, User

authentication > Password
¢ Layout option: Impose

For information about using presets, see printer driver help.

Note: You cannot import or export Local Presets to or from the Mac OS X v10.7 printer driver.

For a list of print options, see Print options and default settings on page 75.
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3 Click Full Properties in the Quick Access pane to specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

¢ Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
job override print option can be added or removed from the view. The Quick Access pane lets you find print
options quickly without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon
in the Windows printer driver on page 30.)

¢ Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 75.)

¢ Media- Attributes and sources of paper to print and insert. (See Media options on page 79.)

¢ Layout- Layout defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
81.)

¢ Color- Color settings and additional features (when turned on). (See Color options on page 92.)

¢ Image- All Image Quality settings supported by the connected FS2000C and printer. (See Image options on
page 99.)

¢ Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in FS2000C Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 101.)

¢ VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Finishing
options on page 101.)

¢ Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 109 or printer driver help.)

¢ Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 30 or printer driver help.)

4 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Customize the Quick Access pane in the Mac OS printer driver

The Quick Access pane can be customized with print options that you use frequently.

This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the FS2000C as your printer.

2 Select Fiery Features from the drop-down list.
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3 Click Customize to specify the options shown in the Quick Access pane.

4 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

5 Click OK to save your changes.

For more information about Quick Access, see printer driver help.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the FS2000C and display them in
the printer driver with the Two-Way Communication option.

You can retrieve its color settings from the FS2000C and display them in the printer driver.

For information about monitoring the status of the printer, see printer driver help.
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Other Printing Methods

You can print jobs with the FS2000C printer driver to the FS2000C, as well as other printing methods, such as
Command WorkStation.

E-mail Service

E-mail Service allows you to control the FS2000C using your current email infrastructure, print to remote locations,
and bypass firewalls.

E-mail Service is not application-specific. You can use any email infrastructure.

The FS2000C supports internal address books. Administrators can retrieve, add, delete, and clear addresses from
address books by sending requests through email. (See Configuration and Setup.)

To set up E-mail Service, see Configure Help.

Use E-mail Service in the following ways:

e DPrint a job from an email application.

To print with an email client, you send a file as an email attachment. E-mail Service extracts the file and sends it
to the FS2000C. The attachment can be in any file format the FS2000C recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: E-mail Service does not process files with .vbs, .exe, or .bat extensions.
e Manage jobs using an email application.

You can manage your print jobs by submitting email commands to the FS2000C using email.
e Scan to E-mail

You can scan a document and send it to an email address as an attachment or URL. (See Utilities.)

Printing using an email client

You can submit print jobs to the FS2000C in the form of an email attachment using your email application.

When you send an email with an attachment, E-mail Service extracts the file and sends it to the FS2000C Print
queue. The file format must be one supported by the FS2000C.

By default, anyone can print with an email client, unless the Print address book has been set up by the administrator.
If the Print address book has been set up and your email address is not in it, you cannot send files to the FS2000C
using email. (See Configuration and Setup.)

When User Authentication is turned on at the FS2000C, the email attachment must have the appropriate user name
and password when it is printed through email printing. As part of creating the email attachment with the FS2000C
printer driver, type the appropriate user name and password on the Job Info tab of the printer driver. The user name
and password must match those defined by the administrator in the Users and Groups section of Configure. For
information about Users and Groups, see Command WorkStation Help.
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Note: The Direct connection is not supported by the email client feature.

When the attached job is printed, the email is also printed, which includes the typical header information, such as
subject, date, sender, and so forth.

Print an email attachment with an email client
You can print an email attachment with an email client.

1 Open your email application.

2 Type the FS2000C email address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.
4

Attach the file that you want to print.
The attachment can be in any file format the FS2000C recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: If your attachment exceeds the file size limitation set by your email administrator, the email is not sent.

e 5
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- “ | — = L Book Mames File Hem L Signature ~ up- | # -
Clipboard ™ Basic Text (F Mames Include F] Options ™= || Proofing
0120123@admincorp. com
=1
e
cons
Subject: Motes
Attached: | Tl Newsletter.pdf (120 KB
Cl
Newsletter to share with team. -
-
4 m | »

I ¥

5 To identify the job or provide further processing instructions, type text in the body of the message.

Note: HTML-formatted email messages are not supported, and might not print as they appear on the remote
workstation. Send email messages in plain text format.
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6 Send the email.
The file is sent to the FS2000C and the job is printed. After the FS2000C receives the job, you receive an email

notification that the print job was accepted. The email provides a job identification (ID). Use job IDs to manage
jobs with email commands. The email notification indicates any current error at the printer. (See Manage print

jobs with email commands on page 62.)

After the job is printed, you receive a second email notification that indicates the job printed successfully.

Manage print jobs with email commands

You can manage your print jobs by submitting commands to the FS2000C using email.

You can cancel a job, check job status, and get help on a job. When you send a command, the FS2000C sends an
email response.

1 In your email application, type the FS2000C email address in the To: line.
2 Type one of the following commands in the Subject line:

¢ To check the status of a job, type #JobStatus<job id> in the Subject line.

You receive a reply to your job status query. You can only get the status of the job if you sent the job or are an

administrator.

¢ To cancel a job, type #CancelJob<job id> in the Subject line.

62

You receive a notification indicating that the job has been canceled and did not print to the FS2000C. You can

only cancel a job if you sent the job.
¢ To get help, type #Help in the Subject line.

You receive an email response that contains links that allow you to cancel jobs, check job status, and search
and manage address books. Click any of the links to perform a command.

3 Send the email to the FS2000C.

Printing from a USB flash drive

You can print files from a USB flash drive to the FS2000C. The FS2000C supports printing from the USB flash drive

using USB Media Server.

The USB port and automatic printing feature must be enabled in Configure, as described in Configuration and Setup

or Command WorkStation Help.

You can manually print files from a USB flash drive when USB Media Autoprint is disabled in Configure.

Files are automatically processed as soon as you connect the USB flash drive to the FS2000C. The files can be from

Mac OS or Windows computers, and can be any of the supported file types (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or

XLS).

Note: The Enable Native Document Conversion Using PrintMe option in Configure must be turned on to print DOC,

PPT, and XLS files.



Printing 63
Other Printing Methods

You can set up folders in the root of the flash drive to correspond to the FS2000C queues:

To send files to one of the standard print queues (print, hold, or direct) on the FS2000C, create folders with those
names in the root of the flash drive, and then drop the files into the folders.

To print any file from the USB flash drive, manually select the file to print, specify where to send it, and select
print options.

Files that are placed at the root level of the USB flash drive are sent to the Print queue.

To send files to a virtual printer that is configured on the FS2000C, create a folder with the virtual printer name
in the root of the flash drive, and then drop the files into the folder. Verify with your administrator that the
virtual printers are published. For more information about virtual printers, see Command WorkStation Help.

Note: If you have more than 50 published virtual printers, you cannot print from a USB flash drive to a virtual
printer.

Print files automatically from a USB flash drive

You can print files automatically from a USB flash drive only if automatic printing is turned on in Configure.

1

Ensure the USB port and automatic printing are enabled, as described in Configuration and Setup or Command
WorkStation Help.

Create folders at the top (root) level of the USB flash drive named print, hold, direct, and the name of any virtual
printer that has been configured and published on the FS2000C.

Save the files (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or XLS) from either the Mac OS or Windows computer to
the USB flash drive, placing the files in the folders that correspond to the action that you want to take.

Connect the USB flash drive to the USB port on the FS2000C.

The files are automatically printed or held according to the folder they are in.

For the location of the USB port, see Configuration and Setup.

After the files have arrived in the related queue, remove the USB flash drive from the FS2000C.

& Important: Make sure that the USB flash drive is properly stopped before you disconnect it from the
FS2000C.

Print using USB Media Server

You can select files to print from a USB flash drive connected to the FS2000C.

When USB Media Autoprint is disabled in Configure, you must manually select the files that you want to print from
the USB flash drive and specify where you want to send them

1
2
3

Ensure the USB port is enabled, as described in Configuration and Setup or Command WorkStation Help.
Insert the USB flash drive into a USB port on the FS2000C.

Make sure the FS2000C is not printing or processing files.
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4 Press the Home button on the printer control panel.

5 DPress the Fiery logo.
The FS2000C screen appears.

You can press the Home button at any time to return to the main screen.
6 Press the button at the bottom of the window (the button is named for the current tab).

7 DPress the USB Media Server tab.
The files and folders on the USB flash drive are displayed on the tab.

8 Navigate to the file that you want to print and select it.
To open a folder, select the folder from the list.

To return to a higher-level folder, press Upper Folder.
9 To navigate through the list of files and folders, you can press the First icon, Prev icon, Next icon, or Last icon.
10 Print one file or all files in the directory.

¢ To print one file, press the Print icon next to a file.

e To print all files in the directory, press Print All located in the upper-right corner of the USB tab window.
11 Specify print options for the file.

¢ Queue (Hold, Print, Direct, or any published virtual printer set up for the FS2000C)

e Copies (default is 1)

¢ Duplex (Default, Off, Top-top, Top-bottom)

e Paper size (Default, list of available page sizes)
12 Press Print to send the file to the FS2000C for printing or Cancel to cancel the print request.
13 Press Services Home button on the printer control panel.

14 Remove the USB flash drive from the FS2000C.

Print and retrieve a secure print job

The Secure Print feature offers a level of security for confidential or sensitive print jobs, which print only when you
are present at the printer control panel.

To use this feature, you first enter an arbitrary password into the Secure print field in the printer driver when you
send your job to the FS2000C. Then, to print your job, you re-enter the password at the printer control panel.
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Send a secure print job

1 Inyour application, do one of the following:

¢ On Windows computers: Select File > Print, select the FS2000C as your printer, click Properties, and then click
the Job Info icon.

e On Mac OS X computers: Select File > Print, select the FS2000C as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then click the Job Info icon in the Printing
Preferences dialog box.

2 Type an arbitrary password in the Secure print field.

Note: The password requires at least 1 character and can be up to 31 characters long. It is limited to
alphanumeric characters and "-", "_", and "." symbols only.

For more information about typing the password, see Job Info options on page 75.
3 Make any other required changes to Job Properties.
4 Click OK to close the FS2000C Properties dialog box.

5 Click OK or Print to close the Print dialog box and send your job to the FS2000C.

The job is sent to the printer.

Retrieve a secure print job from the printer

1 Make sure the FS2000C is not printing or processing files.
2 Press the Home button on the printer control panel.
3 Press the Fiery logo.
The FS2000C screen appears.
You can press the Home button at any time to return to the main screen.
4 Press the button at the bottom of the window (the button is named for the current tab).
5 DPress the Secure Jobs tab.

6 On the Secure Print screen, type the same password that you typed in the Secure print field of the printer driver,
and then press Show Files.

The print jobs that match the password are displayed in the login window.
7 Select your print job and choose Print or Delete.

After 45 seconds of inactivity, the Secure Password screen returns to the main screen.



Printing
Other Printing Methods

FTP printing

You can send jobs to the FS2000C using FTP printing if the FS2000C is set up as an FTP server with FTP Services
configured on it.

For more information about configuring FTP Services, see Command WorkStation Help.

You can use any FTP client application. Before you use FTP printing, the FTP client application requires the
following information (see your administrator):

e IP address or DNS name for the FS2000C

o Directory or path to send the job to, such as the Print queue, Hold queue, or published virtual printers (if
supported)

Note: You cannot print to the Direct connection with FTP printing.
e User name and password (if required)
You can send the following files to the FS2000C:

e PostScript (PS)

e Printer Control Language (PCL)

o Tagged Image File Format (TIFF)
Portable Document Format (PDF)

Note: Encapsulated PostScript (EPS) files are not supported for FTP printing.

Print files to the FS2000C with the FTP protocol

You can use the FTP protocol to print files to the FS2000C.
1 Connect to the FS2000C with your FTP client application.
Folders corresponding to the Print queue, Hold queue, and any published virtual printers are displayed.

2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the appropriate folder.
After the job is printed, it is deleted from the FS2000C.

Adobe PDF Print Engine (APPE)

The Adobe PDF Print Engine (APPE) is an additional interpreter that allows native PDF processing and rendering
without requiring the FS2000C to convert the job from PDF to PostScript.

No special printer driver is required for printing APPE jobs, but the administrator must turn on related settings in
Setup. If APPE is not turned on, PDF files are processed with the PostScript interpreter of the FS2000C. All
PostScript files continue to be processed with the PostScript interpreter.
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The APPE option is not available from the printer driver, but is included in Job Properties in Command
WorkStation. After the administrator turns on APPE as the default in Configure, you can turn on or turn off the
APPE option in Job Properties on a per-job basis.

To turn on the APPE workflow in the FS2000C, see Configuration and Setup.

Print with the APPE workflow

You can use the APPE workflow to print files to the FS2000C.

You can print with the APPE workflow using one of the following methods:

¢ Command WorkStation
Import a job, or drag a job from your computer to the Job Center.
For more information, see Command WorkStation Help.

e Hot Folders
Configure a hot folder for APPE.

For more information, see Hot Folders Help.

Use APPE workflow in Command WorkStation

1 Double-click a PDF job in the Held or Printed list, or select the job and do one of the following:

¢ Right-click to select Properties.
¢ Select Job Center > Properties.

o Select Properties from the Actions menu.

2 Select the Adobe PDF Print Engine Preferred check box.

Job Properties
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Adobe PDF Print Engine Preferred _ Reset
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1 Adobe PDF Print Engine Preferred option
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3 Specify the print option settings, and then click Print.

Print multiple files with APPE workflow

You can print multiple files at the same time with the APPE workflow.

If you open Job Properties for files of different file types, the Adobe PDF Print Engine Preferred option is displayed
only if one of the selected files is a PDF. The print option name is shown as Adobe PDF Print Engine Preferred
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(Applies only to PDF Jobs) and the check box indicates at least one of the PDF jobs selected has been processed
through the APPE workflow.
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1 Adobe PDF Print Engine Preferred (Applied only to PDF Jobs) option

For a multiple file selection containing non-PDF files, the Adobe PDF Print Engine Preferred option is not shown.

If a PDF file contains mixed page sizes when processed using APPE, the Paper size option reflects the size of the first
page in the PDF. If you override the size in Job Properties, all of the pages in the PDF become the selected size.

Access the properties of multiple jobs

You can specify print options for multiple jobs selected at one time.

1 Shift-click to select multiple, sequential jobs, or Ctrl-click to select multiple, non-sequential jobs, and then click
Properties.

Menus for each available print option are displayed in the Job Properties dialog box.

2 After the multiple jobs have opened, specifying a value in the Job Properties dialog box applies it to all jobs.

The Summary tab allows a side-by-side comparison of the specified print options for multiple jobs.

Direct Mobile Printing

Direct Mobile Printing allows direct printing to the FS2000C from mobile devices, such as iPad, iPhone, and iPod
touch.

The FS2000C must have certain networking options turned on in Setup. After Setup is complete, the FS2000C
appears in the list of available printers on the mobile device.

In addition, observe the following configuration requirements:
e Make sure that the FS2000C is connected to a wireless access point on the network.

e Make sure that supported mobile devices are connected to the same wireless network as the FS2000C. The
Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the FS2000C, see Configuration and Setup.

For a list of supported mobile devices, see Configuration and Setup.
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Print from a mobile device

You can print files from your mobile device to the FS2000C.
1 On the mobile device, select the job, and then open the Print window.
For more information, see the documentation that accompanies your device.

2 Select FS2000C in the list of available printers.

3 Specify print settings, and click Print.

PrintMe cloud printing

Users with a PrintMe subscription can upload a document to the PrintMe Cloud Service and then print the
document to the printer using the printer control panel.

Before you print:
e Make sure that the FS2000C has an Internet connection and is connected to the network.
e Turn on PrintMe and related settings on the FS2000C using Configure.

For information about configuring the settings in Setup on the FS2000C, see Configuration and Setup.

e Upload the document to PrintMe, either at http://www.printme.com or send by email to print@printme.com.

For more information about using PrintMe, see EFI PrintMe Cloud Service.

o Print directly from a Windows application. To do this, you must first install the PrintMe printer driver. See
Install the PrintMe printer driver on page 70.

¢ When you upload or email a document to PrintMe, you receive an email confirmation that contains a unique

document ID. You need this document ID to print, as described in the following procedures.

e Make sure that the printer is not printing or processing any files.

o PrintMe supports the following file types: PDF, XLS, DOC, PPT, GIF, JPG, TIFF, PICT, HTML, TXT, and PS.

The maximum file size is 25MB.

Note: The Enable Native Document Conversion Using PrintMe option in Configure must be turned on to print

DOC, PPT, and XLS files.
In particular, observe the following:

e The PrintMe feature on the FS2000C requires a subscription to the PrintMe Cloud Service.

o For information or support related to the PrintMe Cloud Service, contact Electronics For Imaging at
printmesupport@efi.com.

e PrintMe availability may vary, depending on the country or region.

Print a PrintMe document from a printer

You can print an uploaded document from the PrintMe Cloud Service to the printer.
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Make sure the FS2000C is not printing or processing files.

Press the Home button on the printer control panel.

Press the Fiery logo.

The FS2000C screen appears.

You can press the Home button at any time to return to the main screen.

Press the button at the bottom of the window (the button is named for the current tab).
Press the PrintMe tab.

Type the Document ID, press Save, and then click Next.

Refer to the email confirmation for Document ID.

Jobs associated with the Document ID are displayed.

Select a job to print and then press Print Options.

¢ Copies: Use the keypad on the printer control panel to set the number.

¢ Duplex: Select One Side, Duplex (duplex flip left) or Tumble (duplex flip up).

¢ Color mode: Select Color or B/W (black-and-white).

Press Print to print the job.

Press Delete From PrintMe to permanently remove all documents associated with the Document ID from
PrintMe.

Install the PrintMe printer driver

You can print to the PrintMe cloud service just as you would print to any desktop printer with the PrintMe printer
driver.

Note: The PrintMe printer driver is supported on client Windows computers that operate in a non-proxy network
environment.

Install the PrintMe printer driver on a Windows client

You can install the PrintMe printer driver on a Windows client.

1 Go to http://www.printme.com/home/index.html and click Downloads from the PrintMe toolbar.

2 Under Desktops and Laptops, click Download for Windows to download the PrintMe printer driver.

3 Click EFI PrintMe Driver.exe, click Run, and follow the on-screen instructions.

If prompted, restart the computer.
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4 To verify that the driver is set up correctly, click the Start button on the taskbar in Windows and select Devices
and Printers (or Printers and Faxes or Printers).

The EFI PrintMe printer should be listed. If it is not, reinstall the printer driver.

After the PrintMe printer driver is installed, you can print to the PrintMe cloud service from most Windows
applications.

Note: To uninstall the PrintMe printer driver, open the Devices and Printers (or Printers and Faxes) folder or the
Programs and Features tool in the Windows Control Panel and remove the EFI PrintMe Driver.

Print documents from Windows applications
You can print documents with the PrintMe printer driver.
1 In the Windows application, click File > Print.

2 Select EFI PrintMe from the printer pull-down menu.

3 Type your email address and click OK.

i~ i
EFI PrintMe Preferences @

Email: o

Remember my email address

Enable Direct Printing Enter PrintMe ID... Find

[}
m
I

OK Cancel Apply

o ’,

An email message containing the Document ID is sent to your email address.

Print with Fiery JDF

Fiery JDF allows submission of JDF jobs to a FS2000C from applications that allow creation of JDF tickets.
Use Configure to specify JDF settings and to view the Fiery JDF version, the JDF Device ID, and the JMF URL. For
more information, see Command WorkStation Help.
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1 From Configure, choose Job Submission > JDF Settings.

2 Select Enable JDF.

3 Ifavirtual printer is configured for the FS2000C, select one from the Use Job Settings from Virtual Printer option.
Note: Specify this option only if it applies to your specific workflow.

Specify a default print queue from Job Action.

Select Override JDF job with the above settings, if you want to override the settings specified in the JDF ticket.

Specify how you want the JDF jobs closed once they are printed.

N & u b

Specify the items required for closing a JDF job. The items you select here must be filled out before the job can
close automatically or manually.

)

Specify the network paths where the FS2000C searches for common resources.

9 C(lick Save.

Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows 7, Windows 8, and Windows 10 computers, and
Windows 8-based tablets.

The WSD option on the FS2000C must be turned on in Setup. After Setup is complete, you can install the WSD
printer driver for the FS2000C.

For information about configuring the settings in Setup on the FS2000C, see Configuration and Setup.

Install the WSD printer driver

You can install the WSD printer driver on Windows 7, Windows 8, and Windows 10 computers, and Windows 8-
based tablets.

1 Download the printer driver with WebTools.

For instructions on downloading the printer driver with WebTools, see Download printer drivers with WebTools
on page 11.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.
Read the license agreement, click | accept the terms of the license agreement and click Next.

Select Add a network, wireless or Bluetooth printer.

A v A~ W

Select the printer from the list of available printers and proceed to step 10.

Note: The WSD printer shows the FS2000C with the printer in parentheses for the name of the printer.

If the printer is not listed, proceed to step 7.

7 Click The printer that | want isn't listed.
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8 Click Add a printer using TCP/IP address or host name and click Next.

9 Select Web Services Device for Device type, type the IP address of the FS2000C, and click Next.

Connection to the printer is initiated and the printer driver is installed.

10 Click Next and follow the on-screen instructions.

Do not share the printer and do not print a Test Page at this time.
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Print Options

Print Options describes the FS2000C printer driver, available print options, and where to set print options to print
your jobs successfully.

About the FS2000C printer driver

Windows and Mac OS computers communicate with the FS2000C by means of a printer driver and a PostScript
Printer Description (PPD) file. A PPD file contains information about the features and capabilities of a particular
printer (for example, what paper sizes and media types are supported) and the FS2000C.

A printer driver manages printing communication between your application and the printer. It interprets the
instructions generated by the application, merges those instructions with printer-specific options you set, and then
translates all information into Adobe PostScript, a language the printer understands. In other words, the printer
driver writes a PostScript file based on your original file and the options you set from the Print dialog box.

The FS2000C receives files from computers on the network, processes the files, and then sends them to the printer.

For information about the specific print options for the FS2000C, see Print options and default settings on page 75.

Set print options for the job

Print options give you access to the special features of your printer and the FS2000C.

You can specify print options in these areas:

e Setup

Some settings are specified during the initial FS2000C configuration by the administrator. For information about
the current default server settings, contact the administrator or operator.

e Applications
With the printer drivers provided, you can specify job settings when you print a job.
e Color Setup

You can set the default CMYK/Grayscale Source, CMYK/Grayscale Processing Method, RGB Source, Separate
RGB/Lab to CMYK Source, Output Profile, RGB/Lab Rendering Intent, Spot Color Matching, Gray (CMYK),
Gray (RGB), Black Text and Graphics, and Black Overprint settings. (See Color Printing.)
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e Hot Folders

You can assign a group of print options to a Hot Folder. When you specify print options for a Hot Folder, the
print options are assigned to all jobs sent through that Hot Folder. These print options override any default
options.

For information, see Hot Folders Help.
e Overrides in Command WorkStation Job Properties
To change job settings from Command WorkStation, double-click a job to display the Properties dialog box.

For more information, see Command WorkStation Help.

Print option override hierarchy

Print option settings that were specified in the printer driver can be overridden in Command WorkStation Job
Properties.

The override hierarchy is as follows:

o Settings from the user’s printer driver override the FS2000C Setup settings.
o Settings assigned to Hot Folders override the user’s printer driver settings.

e Settings made from the job management tools (Command WorkStation Job Properties) override the user’s
printer driver settings.

Print options and default settings

You can use the printer driver interface to configure a particular print option to print a job. If you choose not to
configure the print option, the FS2000C prints the job with the default setting.

For options that the administrator configures, choosing Printer’s default results in the FS2000C printing the job with
the factory default.

For options that cannot be configured in Setup, the FS2000C prints the job with a preconfigured Printer’s default
setting. When you select the printer driver for North America, the default Document size is Letter or for
International, the default Document size is A4.

To determine the current Setup defaults, print the Configuration page from Command WorkStation. (See
Configuration and Setup.)

Note: A job uses the FS2000C default settings (unless otherwise specified) at the time it is processed for printing, not
at the time it is sent to the FS2000C Hold queue.

The print options are organized according to the printer driver icons (tabs).

Job Info options

The Job Info tab shows all information about the job, including user information that may be required for user
authentication and job handling.
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Accounting: Enable job tracking

The Enable job tracking print option, when selected, turns on job tracking.

To display the job notes and instructions at print time for the job, select Allow entry of account information.

Note: The content in the Notes 1 field will be displayed. The content in the Notes 2 field will not be shown.
To use the last job account information for the print job, select Show last entered account information.
To save the last entered job account information in the job notes, select Use last entered account information.

This option is not available from Command WorkStation Job Properties.

Copies
The maximum number of copies is 9999.
The maximum number of jobs in the Printing queue and Archived list is 2000.

Note: Copies is grayed out and cannot be changed from the Printing Preferences dialog box when Full Properties is
clicked in the Mac OS printer driver. You can specify the number of copies in the application or Mac OS Print dialog
box.

Destination

The Destination print option allows you to specify the location to output the print job.

Destination: Schedule printing

Specify to perform advance print scheduling based on date and time. If you select the check box, then you can select
the date and time for the print job.

The job is always printed at specified date and time regardless of the Print queue action selected, such as Print, Print
and hold, Process and hold, Hold, or Print and delete.

The job is printed based on the date and time set on the FS2000C, not the client computer.

If multiple jobs are selected and defined with the same date and time setting, job order is based on the alphabetical
order of the file names.

Note: This option is invalid if your job is sent to the Direct connection.

Job notes: Notes 1/Notes 2

The Notes print option allows you to specify information about the job.

This field accepts alphanumeric and special characters but does have a maximum limit.

Note: If you enter < or = as the first character, the characters may not be printed in the Job Log, or the application in
use may shut down.
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Job notes: Instructions

The Instructions print option allows you to specify instructions for the operator about the job.

This field accepts alphanumeric and special characters but does have a maximum limit.

Job notes: Print queue action

Select the job action associated with a published queue.
Select Print to send the file directly to printing.

Select Print and hold to save the raster file after printing.
Select Process and hold to process, but not print a job.

Select Hold to spool the job until the operator takes further action. Held jobs can exist in a preprocessed or
processed state.

Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures that the printed
job is not saved to the Printed list.

Note: This option is invalid if your job is sent to the Direct connection.

Job notes: Secure print

The Secure print print option should be used to print sensitive or confidential documents.

Specify an arbitrary password and re-enter it when you are present at the printer.

Print Range

The Print Range print option allows you to specify the page range or odd/even pages to print.

For variable data printing jobs, a range of Records is selected for printing. For imposed variable data printing jobs, a
range of Records and Sheets is printed.

For imposed jobs, a range of Sheets is printed.

Note: If you print a page range within a duplex job and the specified range begins on an even-numbered page, the
page range that is actually printed begins on the page before the specified range. The system automatically changes
the page range to preserve the duplex job pagination.

This option is only accessible from Command WorkStation Job Properties.

Reporting: Control Bar

Control Bar allows you to add a static color bar and dynamic job information to each printed page at a user-defined
location.

The available settings are:
o Off does not print a control bar for the job.

o Fiery is the default control bar that provides a color bar and dynamic job information for the job.
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If you require your own control bar, you can create one by defining custom values on the Control Bar tab in the Color
Setup tab of Command WorkStation.

This option is available as part of Fiery Graphic Arts Package, Premium Edition. For more information, see Fiery
Graphic Arts Package, Premium Edition.

Printer’s default reflects the setting specified in Color Setup in Command WorkStation.

Reporting: Progressives

Select the check box to turn on the Progressives feature, a diagnostic tool used to show toner separations.
This feature uses the Progressives values specified in Color Setup in Command WorkStation.

This option is available as part of Fiery Graphic Arts Package, Premium Edition. (See Fiery Graphic Arts Package,
Premium Edition.)

The Progressives and Postflight features cannot be used at the same time.

Reporting: Postflight

The Postflight print option is a diagnostic tool that allows you to analyze how data is processed by the FS2000C. You
can choose to print an analytical report for a job.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more information, see Fiery
Graphic Arts Package, Premium Edition.

The Progressives and Postflight features cannot be used at the same time.

User authentication: I'm a Guest

The I'm a Guest print option, when selected, allows guest printing.
Guest printing must be turned on at the FS2000C.

In Command WorkStation, the management of jobs is determined by how you log on to the FS2000C.

User authentication: Password

If user authentication is configured on the FS2000C, specify your user Password to print a job. Type your local
password or domain password for user authentication.

User authentication: User name

If user authentication is configured on the FS2000C, specify your User name to print a job. Type your user name or
domain\user name for user authentication.

User authentication: Use Windows Login

If you are logged on to your Windows computer, select Use Windows Login for user authentication. This option
appears when you log on to your domain on your Windows computer.

For more information, see Configuration and Setup.
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Media options

The Media tab shows attributes and sources of paper to print and insert.

Document size

The Document size print option is the page size defined in your application’s Print setup (or Page setup) dialog box.

When printing one document page per sheet of paper, document size is usually the same as output paper size.
However, document size may differ when printing booklets or imposing multiple document pages on a single sheet.

Document size may also differ from output paper size when you use the Scale or Scale to fit options, in which case
the document page size is scaled at a given percent to fit a certain paper size.

To assign document size, do one of the following:
o Select the size from the available list.

SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.
¢ Click Custom to select a non-standard paper size.

Note: The Document size option is grayed out and cannot be changed from the Mac OS printer driver. You can
specify the document size with the Paper size option from the Mac OS printer driver.

Media type

Specify the media type for your print job.

For information about media types and paper specifications, see the documentation that accompanies the printer.

Mixed media

The Mixed media print option allows you to specify different media types, paper sizes, and paper source to use
within a print job.

For more information, see printer driver help.

For information about accessing and using Mixed media, see Command WorkStation Help. Features specific to the
FS2000C are described in Utilities.

Paper Catalog

The Paper Catalog print option provides access to the Paper Catalog utility, which retrieves all paper information
from the printer.

For information about Paper Catalog, see Utilities and Command WorkStation Help.

Note: This option is invalid if your job is sent to the Direct connection.

Access to Paper Catalog requires Two-Way Communication. For information about selecting Two-Way
Communication, see printer driver help.
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Paper size

The Paper size print option defines the size of the sheet of paper on which your job prints. It is the size of the
physical sheet of paper in the printer tray.

To assign paper size, do one of the following:

o Select the size from the available list.
SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.
¢ Click Custom to select a non-standard paper size.

¢ Select Same as document size to print one document page per sheet of paper.

Paper source

Specify the paper tray that contains the paper to use for your print job.
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Auto tray select automatically uses the tray containing the paper size specified for the job. This setting also allows the

printer to automatically switch between trays, if the current tray becomes empty, while continuing to print.

Note: Some trays are options and must first be installed. (See printer driver help.)

For information about setting your choice of media in one of the trays, see the documentation that accompanies
your printer.

Tray alignment

The Tray alignment print option should be selected when you need to adjust the image on the page to achieve
alignment on both sides of a page when printing duplex.

For more information, see Command WorkStation Help.

Use set page device media mapping

The Set Page Device (SPD) feature commands are instructions within PostScript and VPS files that specify certain
attributes of a print job.

The Set Page Device option must be turned on in Configure. (See Command WorkStation Help.)

Select the Use set page device media mapping check box in Job Properties to allow the FS2000C to recognize and
apply certain attributes of a print job on a job-level basis, including:

o DPaper attributes (for example, media type)
o Finishing attributes (for example, stapling or folding)

e Generic attributes (for example, simplex or duplex, number of copies)

This option is accessible only from Command WorkStation Job Properties.
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Layout options

The Layout tab defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray alignment.

The printer driver has the following layout modes:

Normal is used for printing standard documents, from 1 to 16 document pages per sheet. (See Normal layout
options on page 81.)

Gangup is used for speed printing imposition modes. (See Gangup layout options on page 83.)

Booklet is used for printing documents in booklet layout. (See Booklet options in the printer driver and Job
Properties on page 84.)

Impose is used for imposition layouts for custom printing, binding, and trimming. (See Impose layout options on
page 91.)

Normal layout options

Normal layout options are used for printing standard documents, from 1 to 16 document pages per sheet.

Normal

Select Normal to specify options for printing standard documents.

Duplex

The Duplex print option allows you to print a job with duplex (double-sided) pages.
Select Off for single-sided printing.

Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed
images.

For more information, see Print Duplex (double-sided) pages on page 125.

Mirror

The Mirror print option, when selected, prints the mirror image of the job.

This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.

Orientation override

The Orientation Override print option is used with jobs that do not have an orientation or that have incorrect
orientation.

It specifies the orientation to use for finishing settings (for example, stapling) that interact with orientation and
for flowing pages on N-up layouts. In some cases, the orientation of a job may be correct in print, but incorrect
in preview.

This option is accessible only from Command WorkStation Job Properties.
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Orientation

Specify Portrait or Landscape page orientation for the document.

This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.

N-up option: Page Order

Specify the layout direction when the Pages per Sheet option is set to 2-up or greater.

N-up option: Pages per Sheet

Specify the number of document pages per sheet of paper for your print job.

This option cannot be used with the Create master or Use master options.

Note: This option is invalid if your job is sent to the Direct connection.

N-up option: Print border

Select to turn on Print border to print borders around each page in your print job.

Scale

Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you cannot
specify Scale to fit.

The operator can specify a scaling override in Command WorkStation, but the override is applied to any scaling
value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator
specifies a Scale override of 300%, the job is printed at 150% of the original document size, that is, 50% of 300%.

Scale to fit

The Scale to fit option allows you to specify whether to scale your job to fit to a paper size. When using the Scale
to fit option, you cannot use the manual Scale option.

The Scale to fit option allows you to scale a job to a paper size different from the document size. When you turn
on this option, the image is increased or reduced in size to fit the imageable area of the paper size you select
from the Paper size menu. The document size is scaled to the printable imageable area of the paper for edge-to-
edge printing. When you turn off this option, the original document size is printed without any scaling, even if
you select a larger paper size.

Scale to fit option Document size - Letter Output paper size - 11x17

Scale to fit turned on




Printing 83
Print Options

Scale to fit option Document size - Letter Output paper size - 11x17

Scale to fit turned off

Gangup layout options
Gangup layout options are used for speed printing imposition modes.

Note: The Gang-up feature is not valid if your job is sent to the Direct connection.

Gangup

Select Gangup to specify options for speed printing imposition modes.

Gang-up type

Gangup booklet has two types used for speed printing imposition: Step & repeat and Cut & stack.

Select Step & repeat to speed print a job by printing two document pages on each sheet. When the printed
sheets are cut in half, the result is two complete sets of the same document.

Select Cut & stack to speed print a job by printing two document pages side by side. When the printed sheets are
cut in half and stacked together, the result is one complete set of the document (in faster printing time).

For more information, see Gang-up printing on page 121.

Page Alignment: Duplex

The Page Alignment: Duplex print option allows you to select the duplex (double-sided) setting to specify the
orientation of printed images for gang-up printing.

Select Off for single-sided printing.
Specify Top-top for duplex (double-sided) printing by specifying the orientation of printed images.

For more information, see Print Duplex (double-sided) pages on page 125.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.

You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).

Specify a positive value to increase the amount of blank space between adjacent pages.
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Specify a negative value to decrease the amount of blank space between adjacent pages.

For more information, see Booklet Maker Help.

Paper size

The Paper size print option defines the size of the sheet of paper on which your job prints. It is the size of the
physical sheet of paper.

To assign paper size, select one of the following:
o Select the size from the available list.

¢ Choose Select From Paper Catalog to access a dynamic database on the FS2000C that stores the media
attributes of any paper available for printing.

o Select Custom Paper Size to select a non-standard paper size.
¢ Select Same as document size to print on a sheet of paper the same size as the original document page size.
For information about Document size and Paper size, see Document size and Paper size on page 118.

For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see
Command WorkStation Help.

Paper Size: Shrink to fit

Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size
specified from the Paper size menu. Shrink to fit does not scale up or enlarge.

Select one of the following settings:
¢ Sheetsize - shrinks the page contents to fit the sheet size.
o Off - prints the page contents at 100%.

¢ Imageable area - shrinks the page contents to fit the imageable area.

Booklet options in the printer driver and Job Properties

Booklet layout options are used for printing documents in booklet layout.

The Booklet Maker print options accessible from the printer driver. For the Booklet Maker print options accessible
from Command WorkStation Job Properties, see Booklet Maker in the printer driver and Command WorkStation
Job Properties on page 113.

Note: The Booklet Maker feature is not valid if your job is sent to the Direct connection.

You can use the Booklet Maker Wizard to specify booklet options by clicking Launch Wizard.

Booklet

Select Booklet to specify options for printing documents in Booklet layout.

Click Launch Wizard to specify how to arrange the pages of the job in special layouts for folding or cutting after
printing.
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Booklet Type

Booklet Type is a combination of binding method, which determines how the signatures of the booklet are
folded and imposed, and binding edge, which determines the location of the spine of the booklet.

For information about 1-up Perfect binding booklets, see 1-up Perfect Binding Booklet options on page 87.

For information about Booklet printing, see Booklet Maker Help.

Cover: Back cover
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When Front & Back Separately is selected for the Cover: Content input print option, use the Back cover option to

define how the content of the back cover is printed.

Select Print on outside to print only on the outside of the back cover (the inside of the back cover is blank).
Select Print on inside to print only on the inside of the back cover (the outside of the back cover is blank).
Select Print on both sides to print on both the inside and outside of the back cover.

Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures in the
job. For more information, see Booklet Maker Help.

Cover: Content input

The Content input print option provides cover type settings for your Saddle booklet.

Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job.

Select Pre-Printed (use insert) to insert a pre-printed cover that is added to the body pages from an inserter tray.

For more information, see Booklet Maker Help.

Cover: Define Cover (for Saddle books only)

Click Define Cover to specify the cover options.

Cover: Front cover

When Front & Back Separately is selected, use the Front cover option to define how the content of the front
cover is printed.

Select Print on outside to print only on the outside of the front cover (the inside of the front cover is blank).
Select Print on inside to print only on the inside of the front cover (the outside of the front cover is blank).
Select Print on both sides to print on both the inside and outside of the front cover.

Select Do not print if you do not want any content printed on the front cover.

When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures. For
more information, see Booklet Maker Help.
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Page Alignment: Align pages
Align pages positions page content in relation to the center of one-half the paper size or the spine, the center of
the sheet where the fold occurs.
At the center positions page content in the center of one-half the specified paper size.
At the spine aligns page content with the spine or center fold of your booklet.

For more information, see Booklet Maker Help.

Page Alignment: Compensate creep

Compensate creep adjusts the position of the page content to counteract the shift that occurs when sheets are
folded and combined to create Saddle and Nested Saddle booklets.

Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.

For information about printing booklets, see Booklet Maker Help.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.

You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).

Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.

For more information, see Booklet Maker Help.

Paper size: Paper Size for 2-up

The Paper Size for 2-up print option defines the size of the sheet of paper (unfolded) on which a booklet is
printed. It is the size of the physical sheet of paper.

To assign a paper size for a booklet, select one of the following:

e Select the size from the available list.

¢ Choose Select From Paper Catalog to access a dynamic database on the FS2000C that stores the media
attributes of any paper available for printing.

¢ Select Custom Paper Size to select a non-standard paper size.

o Select Same as document size to print on a sheet of paper the same size as the original document page size.

For information about Document size and Paper size, see Document size and Paper size on page 118.

For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see
Command WorkStation Help.

For more information about printing booklets, see Booklet Maker Help.
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Paper Size: Shrink to fit

Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size
specified from the Paper size menu. Shrink to fit does not scale up or enlarge.

Select one of the following settings:
o Sheet size - shrinks the page contents to fit the sheet size.
o Off - prints the page contents at 100%.

¢ Imageable area - shrinks the page contents to fit the imageable area.

Subset Size: Number of sheets in a subset (saddle) (for Nested Saddle books only)

When Nested Saddle is selected for booklet type, use the Number of sheets in a subset (saddle) print option to
specify the number of sheets in each subset.

1-up Perfect Binding Booklet options

The 1-up Perfect Binding Booklet layout options are used for printing documents in booklet layout where single
body pages are stacked together, so that the edges may be trimmed (if desired) and glued, and then wrapped by a
cover sheet.

1-up Perfect binding

To print a 1-up Perfect binding booklet, your printer must be equipped with an advanced finisher that supports
Perfect binding.

Select a binding method for the 1-up Perfect booklet:
o Select Left Binding for a book that reads from left to right, with the spine (binding edge) at left.
e Select Right Binding for a book that reads from right to left, with the spine (binding edge) at right.

¢ Select Top Binding for a book that reads from top to bottom, with the spine (binding edge) at the top.

For more information, see Booklet Maker Help.

Body Paper Size

The Body Paper Size print option allows you to specify the paper size for the body pages of the booklet.
To select a Body Paper Size for your booklet, do one of the following:
o Select from the list of available sizes.

SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.

e Choose Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper
available for printing from the FS2000C.

e Select Custom Paper Size to create a non-standard paper size, using the Custom Paper Size width (feed edge)
and height dimensions.
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o Select Same as document size to print one document page per sheet of paper.
¢ Select Edit to define media attributes for the body paper size.

For more information, see Booklet Maker Help.

For information about accessing Paper Catalog, see Utilities.

For information about using Paper Catalog, see Command WorkStation Help.

For information about document size and paper size, see Document size and Paper size on page 118.

Body Position: Booklet scaling

Specify how to scale the document pages in the 1-up Perfect booklet.
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Select Shrink to body size to automatically scale down the document page to fit the paper size specified from the

Body Paper Size menu.

Specify None when booklet scaling is not necessary.

Body Position: Align pages
The Align pages print option positions page content in relation to the center of one-half the paper size or the
spine, the center of the sheet where the fold occurs.
At the spine aligns page content with the spine or center fold of your booklet.
At the center positions page content in the center of one-half the specified paper size.

You can fine-tune the alignment of the page content vertically (parallel to the spine) or horizontally
(perpendicular to the spine) by specifying values.

For more information, see Booklet Maker Help.

Body Position: Custom adjustment horizontally or vertically

You can fine-tune the alignment of the body page content horizontally (perpendicular to the spine) or vertically

(parallel to the spine).
You can specify the adjustment value in 0.001 inch increments (0.1 mm increments).
Specify a positive value to increase the amount of blank space between the body pages and the binding edge.

Specify a negative value to decrease the amount of blank space between the body pages and the binding edge.

Cover Content: Back cover

When Front & Back Separately is selected, use the Back cover option to define how the content of the back cover

is printed.
Do one of the following:

o Select Print on outside to print the cover content only on the outside of the back cover (the inside of the
back cover will be blank). This is the default setting.

o Select Print on inside to print the cover content only on the inside of the back cover (the outside of the back

cover will be blank).
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o Select Print on both sides to print on both the inside and outside of the back cover

¢ Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures.
The back cover content pages must be specified as the second to last and last pages within the source document.
This option is available when the Content input option is Front & Back Separately.

For information about cover options, see Booklet Maker Help.

Cover Content: Content input

Specify the cover type for your booklet.

Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job. This is the default setting.

Select Pre-Printed to insert a pre-printed cover that will be merged with the body pages of your booklet, which
print separately.

For information about cover options, see Booklet Maker Help.

Cover Content: Content

The Content print option allow you to decide whether your cover content prints on the outside or both sides of
the cover.

Do one of the following:

e Select Outside of the cover to print the cover content only on the outside of the cover (the inside of the cover
will be blank). This is the default setting.

o Select Both sides of the cover to print content on both the inside and outside of the cover.

This option is available when the Booklet Type print option is 1-up Perfect, and Content input print option is
Front & Back Together.

Cover Content: Front cover

The Front cover options allow you to quickly decide whether your front cover prints duplex, single-sided, or
both sides blank, without needing to add blank pages in your original document.

Do one of the following:

¢ Select Print on outside to print the cover content only on the outside of the front cover (the inside of the
front cover will be blank). This is the default setting.

o Select Print on inside to print the cover content only on the inside of the front cover (the outside of the front
cover will be blank).

e Select Print on both sides to print on both the inside and outside of the front cover.
¢ Select Do not print if you do not want any content printed on the front cover.
When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures.

The front cover content pages must be specified as the first and second pages within the source document.
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This option is available when the Content input option is Front & Back Separately.

For information about cover options, see Booklet Maker Help.

Cover Content: Spine content

Specify how to print content on the spine of your booklet.
Select None if you wish to not print on the spine of the booklet. This is the default setting.

Select Document page to print content on the spine of the booklet. Printing of the spine is achieved by using the
last document page as the spine.

For top binding, the spine content is rotated 180 degrees to ensure the spine content is in the correct orientation
for reading.

This option is available when the Content input option is Front & Back Separately.

Cover Content: Spine width

Specify the value for the spine width of the booklet. The spine width value is used to determine the trim amount,
and cover paper size.

When the Content input option is Front & Back Separately, the spine width value is used to determine the
distance between the front and back cover content.

When the Content input option is Front & Back Together or Pre-printed, the cover content has already been
printed or included in the document source, therefore the spine width does not alter the cover layout.

Cover Position

Specify the placement of the cover content to be centered vertically and horizontally within the cover sheet.
You can specify the cover position value in 0.001 inch increments (0.1 mm increments).
Specify a positive value to increase the amount of blank space between the cover pages and the spine.

Specify a negative value to decrease the amount of blank space between the cover pages and spine.

Cover Paper Size

The Cover Paper Size print options allows you to specify the cover paper size for the booklet cover.
To select a Cover Paper Size for your booklet, do one of the following:
e Select from the list of available sizes.

¢ Select Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper
available for printing from the FS2000C.

o Select Custom Paper Size to create a non-standard paper size, using the Custom Paper Size width (feed edge)
and height dimensions.

o Select Edit to define media attributes for the cover paper size.

For more information, see Booklet Maker Help.

For information about accessing Paper Catalog, see Utilities.
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For information about using Paper Catalog, see Command WorkStation Help.

For information about document size and paper size, see Document size and Paper size on page 118.

Mixed Media

The Mixed Media print option allows you to make selections that affect the pagination and the sheet layout for
the print job.

When Mixed Media is used in Booklet Maker, it will be disabled in the Media tab, but selections made in Mixed
Media in 1-up Perfect binding are displayed in the Media tab and in Compose.

In the Mixed Media area, specify the chapter start pages, define the page ranges and media, and new blank
inserts and media.

Note: The Define Each chapter as a Separate Finishing Set print option is not available as it is in the Mixed
Media area in the Media tab.

Implicit and explicit blanks are denoted by different thumbnails. Implicit blanks are inserted when the page is
designated as a chapter start in a two-sided (duplex) job. Explicit blanks are those inserted by the user.

The Sheet tab presents the pagination of the job with the order of the sheet as the primary focus. The sheets are
presented in linear order, which corresponds to the actual print order on the printer. The cover is always
presented first, even if the cover may be printed as the last sheet.

The Page tab presents the pagination of the job with the order of the document page as the primary focus. The
pages are presented in linear order, which corresponds to the logical reading order of the source document.

The Mixed Media option for 1-up Perfect binding is only accessible from Command WorkStation Job
Properties.

Unit

Specify the units for the booklet.

Impose layout options

Fiery Impose provides several pre-defined imposition templates used for custom printing, binding, and trimming.
Impose is an option on the FS2000C.
The Impose option is only accessible from Command WorkStation Job Properties.

For more information, see Command WorkStation Help.

Impose

Select Impose to specify an imposition layout for a job.
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Templates

Specify an imposition layout template for a job.

The available templates are as follows:

e Normal: Default Template and 1-up full bleed

e Booklet: 2-up perfect, 2-up saddle, and 4-up head to head

e Gangup: 3-up trifold brochure, 4-up gate fold, and 4-up z fold

Edit Impose Template

You can edit the imposition template in Fiery Impose.
Click Edit Impose Template to open a template in Fiery Impose for editing.

For information about Impose, see Utilities. For information about using Impose, see Command WorkStation
Help.

Color options

The Color tab shows color settings and additional features (when turned on).

Color mode

Select the color mode for the current print job.

Specify the color mode for the print job by doing one of the following:

Select CMYK for a color document.

Select CMYK+ to print color output with CMYK colorants plus a fifth colorant, using all colorants as process
colors. The fifth colorant can be Red or Gray. For more information, see Color Printing.

Select Grayscale for a grayscale or black-and-white document.

Specify the color print options and settings by doing one of the following:

Select Basic Settings to specify color print options and settings. For more information, see Basic color options on
page 92.

Select Expert Settings to edit other color print options and settings, including Black overprint and Black text and
graphics. For more information, see Expert color options on page 95.

Basic color options

The basic color options can be accessed by clicking Basic Settings on the Color tab of the printer driver or Command
WorkStation Job Properties.

Basic Settings are as follows:

CMYK/Grayscale Source specifies the simulation profile for the print job.

RGB Source specifies a source color space definition for printing RGB images, graphics, and text.
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e Spot Color activates the PANTONE Lookup Table. The FS2000C uses a built-in table to generate the closest
CMYK matches of spot colors when the Spot color matching check box is selected.

e Gray and black specifies the settings to use for the object types (Text/Graphics or Text/Graphics/Images) using
black only.

e Output Profile uses selected profile for color conversion for the printer.

e (Calibration is done with Color Profiler Suite, and the last date and time the calibration was updated for the
printer is shown.

2-color print mapping

The 2-color print mapping option can be used to replace spot colors and process colors to the generic colors.

Select the 2-color print mapping check box to replace spot colors and process colors with generic colors when you
create a print job.

This option is available as part of Fiery Graphic Arts Package, Premium Edition. (See Fiery Graphic Arts Package,
Premium Edition.)

Auto trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an application, in order to
prevent white edges around the objects.

These white edges, or “halos,” can be caused by factors such as misregistration, the physical properties of the inks,
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and the stiffness of the media. The Auto trapping feature provides you with advanced trapping settings and gives you

full control over their values.

Select this option if the job should automatically reduce white gaps for text and graphics.
Turning on this option may result in graphics or text surrounded with borders.

For more information, see Color Printing.

Configurable auto trapping is available as part of Fiery Graphic Arts Package, Premium Edition. For more
information, see Fiery Graphic Arts Package, Premium Edition.

Combine separations
You can print the color separations in the job as a single page or as four individual pages.
When printing separations from supported desktop publishing applications, do one of the following:

e Select the Combine separations check box to combine separations on a single page.

e Clear the check box to view separations as individual black-and-white pages, each representing one color plate.

For more information, see Color Printing.
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Composite overprint

Design applications are typically set to knock out objects.

To overprint, you must first change the settings in the source application. When the Composite overprint option is
turned on, the overprinting attribute specified in the source application takes place, provided the output is in
composite mode (not printed in separations) and/or is printed with CMYK or Grayscale color mode. (See Color
Printing).

Select this option to overprint objects that are specified in the source PostScript or PDF file.

ImageViewer Curves

The ImageViewer Curves print option lets you apply color curve edits from ImageViewer that have been saved on the
server as a preset.

ImageViewer in Command WorkStation can be used to edit the CMYK curves of a job on the FS2000C. These curve
edits can be saved as a preset and applied to other jobs. Use the ImageViewer Curves option to select a preset for
your job.

Factory-supplied curve edits apply some typical color corrections:
o Lighter highlights

e Midtone boost

¢ No correction

e Shadow detail

e Reduce C (cyan) cast

e Reduce M (magenta) cast

e ReduceY (yellow) cast

After the job is processed, the edits become part of the job and are no longer visible as edits when you view the job in
ImageViewer.

For more information, see Color Printing.

Substitute colors

Select Substitute colors to use the substitute color values defined in Spot-On.

For more information, see Color Printing.

Optimize RGB transparency

You can use the Optimize RGB transparency option to achieve correct color output for areas of overlapping
transparent RGB or Lab colors (such as a drop shadow) in a PDF job.

Turn on to achieve correct color output for areas of overlapping transparent RGB or Lab colors (such as a drop
shadow) in a PDF job.
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If you turn on Optimize RGB Transparency, the FS2000C uses the correct RGB source profile and rendering intent
when converting the overlapping RGB colors to CMYK during the PDF-to-PostScript conversion. If you turn off
Optimize RGB Transparency, the area of overlapping colors might print with incorrect color or undesirable artifacts.

When Adobe PDF Print Engine Preferred is turned on, this option is to recognize blending color spaces in the job,
which can improve output for some blend modes when RGB blending color spaces are used.

This option is only accessible from Command WorkStation Job Properties, Hot Folders, and Virtual Printers. (See
Color Printing).

Expert color options

The expert color options can be accessed by clicking Expert Settings on the Color tab of the printer driver or
Command WorkStation Job Properties, and then clicking the Color Input tab in the Advanced Edit dialog box.

Expert Settings modes are as follows:

¢ Color Input is used for color printing. (See Color Input options on page 95).

o Gray &Black Processing is used to specify how to print black text and graphics in the print job. (See Gray & Black
Processing options on page 97).

e Output is used to specify the output profile to use for printing a document. (See Output options on page 99).

Color Input options

The Color Input options can be accessed by clicking Expert Settings on the Color tab of the printer driver or
Command WorkStationJob Properties, and then clicking the Color Input tab in the Advanced Edit dialog box.

Black point compensation

The Black point compensation option lets you control the output quality of shadow areas for CMYK source
colors.

Use Black point compensation to enhance details in shadows when the CMYK source space is larger than the
gamut of the printer. In proofing applications, when the CMYK source space is smaller than the gamut of the
printer, do not use this option.

Note: For RGB source colors, black point compensation is always applied.

Black point compensation works by scaling the source colors so that the darkest point in the source profile maps
to the darkest point in the output profile.

For more information, see Color Printing.

CMYK/Grayscale Processing method

Specify the CMYK/Grayscale Processing method for the print job.
Specify the simulation method for CMYK print jobs.
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Do one of the following:

Select Full (Source GCR) for a more complete and accurate simulation. Full (Source GCR) applies colorimetric
transformations that adjust hue as well as output density and produces output that maintains the same
amount of black as the source document.

Select Full (Output GCR) to apply the same simulation method as Full (Source GCR), except that the output
produced contains a black amount determined by the Output profile.

Select Pure Primaries to use one-dimensional transfer curves to adjust density output of individual color
channels.

For more information, see Color Printing.

CMYK/Grayscale Source

Specify the simulation profile for the print job.

For more information, see Color Printing.

Paper simulation

Select the Paper simulation check box to adjust the color according to the shade of the paper stock specified in
the selected CMYK/Grayscale source profile.

This option is available as part of Fiery Graphic Arts Package, Premium Edition. For more information, see Fiery
Graphic Arts Package, Premium Edition.

PDF/X output intent

Select the PDF/X output intent check box to use the embedded output intent for PDF/X compliant print jobs.

To use this option, you must turn on the Use Embedded Profile When Present (RGB) option.

This option is only accessible from Command WorkStation Job Properties. (See Color Printing)

RGB rendering intent

Specify a RGB rending intent for the print job.

Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, graphics,
and text.

Do one of the following:

Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered flesh tones and more saturated colors.

Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.
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Note: If you experience tone reproduction problems, set this option to Photographic.

For more information, see Color Printing.

RGB Source

Specify a source color space definition for printing RGB images, graphics, and text.

For more information, see Color Printing.

Separate RGB/Lab to CMYK source

Select the Separate RGB/Lab to CMYK source option for RGB jobs to simulate an output printer other than the
printer to which you are printing.

For more information, see Color Printing.

Spot color matching

Clear the Spot color matching check box to print specified PANTONE colors in your job using the alternate
color space and values for the spot color specified in the source application.

Select to activate the PANTONE Lookup Table. The FS2000C uses a built-in table to generate the closest CMYK
matches of spot colors. (See Color Printing.)

Use embedded profile when present (RGB)

When the Use embedded profile when present (RGB) option is turned on, the FS2000C ignores the RGB Source
option and uses the RGB profile embedded in the print job as the RGB source profile.

For more information, see Color Printing.

Use embedded profile when present (CMYK)

When the Use embedded profile when present (CMYK) option is turned on, the FS2000C ignores the CMYK/
Grayscale Source option and uses the CMYK profile embedded in the print job as the CMYK source profile.

For more information, see Color Printing.

Gray & Black Processing options

The Gray & Black Processing options can be accessed by clicking Expert Settings on the Color tab of the printer driver
or Command WorkStation Job Properties, and then clicking the Gray & Black Processing tab in the Advanced Edit
dialog box.
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Black text and graphics

The Black text and graphics print option specifies how to print black text and graphics in the print job.

Do one of the following:

o Select Normal to print black text and graphics as a four-color black using C, M, Y, and K, and to use normal
PostScript rendering.

e Select Pure Black On to print black text and graphics as a one-color black, using black only.

¢ Select Rich Black On to print black text and graphics as richer looking black, by layering a small amount of
Cyan underneath the black to make the black even darker.

This option is automatically set to Pure Black On if the Black overprint (for pure black) option is set to Text or
Text/Graphics. (See Color Printing.)

Black overprint (for pure black)

The Black overprint (for pure black) print option provides settings for text or text/graphics to overprint in the
job.

Do one of the following:
e Select Off to use conventional processing by knocking out. May produce white halos around objects.
o Select Text to overprint black text.

o Select Text/Graphics to overprint black text and graphics.

For more information, see Color Printing.

Gray (RGB)

The Gray (RGB) print option provides settings to print an RGB job using black instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black instead of CMYK black, when any RGB color has equal R, G, and B values. (Graphics refer to vector
graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

Gray (CMYK)

The Gray (CMYK) print option provides settings to print a CMYK job using black instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black instead of CMYK black, when any CMYK color with C, M, and Y are 0 (zero), and K is any value is printed.
(Graphics refer to vector graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).
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Output options

The Output options can be accessed by clicking Expert Settings on the Color tab of the printer driver and Command

WorkStation Job Properties, and then clicking the Output tab in the Advanced Edit dialog box.

Default output profile

The Default output profile print option specifies the output profile used to process a job. Color data in a print
job is converted to the color space of the printer, which is described by the output profile.

The Use job defined settings setting automatically selects the output profile associated with the color mode and
media type used in a print job rather than a specific output profile. If a job uses media from Paper Catalog, the

output profile specified for the media in Paper Catalog is used.

For more information, see Color Printing.

Use job defined settings (if available)

Select Use job defined settings to automatically select the output profile associated with the media type used in a

print job rather than a specific output profile.

For more information, see Color Printing.

Image options

The Image tab shows all image quality settings supported by the connected FS2000C and printer.

For information about options specified in Setup, see Configuration and Setup.

Barcode: Barcode processing for graphics

The Barcode processing for graphics print option applies barcode processing on graphic objects.

Barcode: Barcode processing for images

The Barcode processing for images print option applies barcode processing on image objects.

Barcode: Barcode processing for texts

The Barcode processing for texts print option applies barcode processing on text objects.

Brightness

The Brightness print option allows you to specify the image brightness for the print job.

Select 85% lightest for a substantially lighter image, 115% darkest for a substantially darker image, or one of the
settings in between.
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Draft mode

The Draft mode print option allows you to save ink. When the option is turned on, the entire image is lightened.

This mode is typically used for printing draft documents.

Halftone mode

The Halftone mode print option allows you to select a halftone screening method for your print job.
The available settings are:

o Standard uses the FS2000C halftone screening with a resolution of 300x300 dpi.

e Fine uses the FS2000C halftone screening with a resolution of 300x600 dpi.

¢ Envelope standard uses the FS2000C halftone screening with a resolution of 300x300 dpi for text edge
enhancement.

e Envelope fine uses the FS2000C halftone screening with a resolution of 300x600 dpi for text edge enhancement.

o High speed uses the FS2000C halftone screening with a resolution of 300x300 dpi for faster processing.

Image enhance: Apply image enhancement

The Apply image enhancement option, when selected, applies photo enhancement to the job.
The supported file formats are PDF, PS, TIFF, and EPS.
This option is not valid for images under 72 dpi. Also, it is not applied to pages with a large number of images.

For more information, see Image Enhance on page 122.

Image enhance: Image enhancement range

Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.

Image smoothing

Select the Image smoothing option to minimize grainy output when printing low-resolution (up to 300 dpi) images.

This option is valid for images less than or equal to 150 dpi when the Resolution option is set to 600 dpi, and for
images less than or equal to 300 dpi when the Resolution option is set to 1200 dpi. This option improves graphic and
image types of gradients.

Image quality

The Image quality print option allows you to specify the type of image quality for the job.

This option affects the fineness of images in the job; there is a trade-off with processing speed.
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Choose one of the following for the print job:
¢ Normal - to print quality images.

¢ Best - to print the highest quality for text and images.

Max ink volume

The Max ink volume print option allows you to select the maximum amount of ink to print on the selected media.
Select Media defined to use a preset maximum ink volume for the selected media.

Select 1 through 11 to set the maximum ink volume to use for the selected media.

Monochrome printing

The Monochrome printing print option allows you to print grayscale in a different color other than black on paper
types that are not covered by the default paper types.

The Color mode print option must be set to Grayscale, then you can select Cyan or Magenta for Monochrome
printing.

When Monochrome printing is not used, then grayscale is printed in true black (K) and white.

Print density

The Print density print option allows you to increase or decrease the output density for your job.

Selecting a negative number will decrease the value and result in the print being lighter. Selecting a positive number
will increase the value and result in the print being darker.

Finishing options
The Finishing tab shows print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options.

These options override settings in FS2000C Printer Setup but can be changed from Command WorkStation.

Cover page

The Cover page print option, when selected, prints a cover page with detailed job information after the last sheet of
the job.

When Cover page is enabled on the FS2000C, it is turned on for all jobs. By default, Cover page prints on the same
media as the body of the job. For information about options specified in Configure, see Configuration and Setup.

The Cover page print option can be configured using one of the following settings:
¢ Same as job — uses the same media as the body of the job

e Custom — allows you to select specific media.
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Note: Changes to the Cover page settings in Job Properties will override the Cover page setting in Configure for the
specific job.

Delivery Option: Collate

The Collate print option allows you to specify how to output multiple-page/multiple-copy jobs.

e Sort: Copies of a complete job are sorted as 1-N, 1-N.

¢ Group: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

Note: This option is invalid if your job is sent to the Direct connection.

Note: The collation of Mixed Media and Variable Data Printing (VDP) jobs is handled differently. For Mixed Media
jobs, copies of a complete job are sorted according to finishing set. For VDP jobs, copies of a complete job are sorted
per record.

For information about VDP, see Variable Data Printing.

For information about Mixed Media, see Utilities.

Delivery Option: Continuous output

The Continuous output print option, when selected, switches from one output tray to another output tray
automatically if the output tray becomes full while printing.

Delivery Option: Offset jobs

The Offset jobs print option, when selected, offsets (shifts in output tray) the job.

The settings are as follows:

o Off: Copies of a complete job are not offset in the output tray.

¢ Between jobs: Completed jobs are sorted as 1-N, 1-N with offset stacking in the output tray.

¢ Between sets: Completed jobs are sorted as 1,1, 2,2, 3,3 with offset stacking in the output tray.

Delivery Option: Output delivery

The Output delivery print option allows you to specify the output delivery for the printed job.

Do one of the following for single-side printing:

e Select Face down - normal order to print your document on the bottom of the sheet of paper (the document
outputs from the printer with the text facing down) in normal (1-N) order.

o Select Face up - normal order to print your document on the top of the sheet of paper in normal (1-N) order.

¢ Select Face down - reverse order to print your document on the bottom of the sheet of paper (the document
outputs from the printer with the text facing down) in reverse (N-1) order.

o Select Face up - reverse order to print your document on the top of the sheet of paper in reverse (N-1) order.
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Do one of the following for 2-sided (duplex) printing:

o Select Face down - normal order to print your document, for example 4 pages, with page 4/last page on the front
of the sheet of paper and page 3 on the back, and page 2 on the front of the next sheet of paper and page 1 on the
back in normal (1-N) order).

¢ Select Face up - normal order to print your document, for example 4 pages, with page 1 on the front of the sheet
of paper and page 2 on the back, and page 3 on the front of the next sheet of paper and page 4/last page on the
back in normal (1-N) order).

o Select Face down - reverse order to print your document, for example 4 pages, with page 2 on the front of the
sheet of paper and page 1 on the back, and page 4/last page on the front of the next sheet of paper and page 3 on
the back in reverse (N-1) order).

o Select Face up - reverse order to print your document, for example 4 pages, with page 3 on the front of the sheet
of paper and page 4/last page on the back, and page 1 on the front of the next sheet of paper and page 2 on the
back in reverse (N-1) order).

For more information, see Output delivery on page 122.

Delivery Option: Output tray

The Output tray print option allows you to specify the output tray for the job.

Delivery Option: Print and pause

The Print and pause print option, when selected, prints a single copy of a job(s) to verify output.

A print job is stored and only one copy is printed. The remaining copies print after you enter information from the
printer control panel.

This function is available only when you print multiple-copies.
To print the document, release the held document from the printer control panel.

For information, see the documentation that accompanies your printer.

Delivery Option: Rotate 180

The Rotate 180 print option, when selected, allows you to rotate the pages of your job 180 degrees.

Delivery Option: Slow printing

The Slow printing print option, when selected, prints the job at slower speed to lower the operating noise.

Fold: Fold order

The Fold order print option allows you to specify whether the pages of your folded job print with the imageable area
on the inside or outside of the folded sheet.

For more information, see Fold style options on page 120.
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Fold: Fold style

The Fold style print option allows you to specify a fold style for the print job.

Fold: Z-fold binding edge

The Z-fold binding edge print option allows you to specify the location of binding edge for the fold.
If Z-fold for Fold style and Perfect for Booklet Type are selected, then this option is turned on.
To use this option, you must install a finisher with folding functionality.

For information about installing finishers and other installable options, see printer driver help.

Z-fold mixed size

The Z-fold mixed size print option, when selected, allows you to z-fold mixed paper sizes.

Image shift

The Image shift print option check box, when selected, adjusts an image for duplex printing by shifting the image
horizontally, in the direction of paper travel, relative to the leading edge.

This option affects the offsetting of the image for the entire job, not on a per-page-basis. However, you can specify
alignment settings for the front (odd) and back (even) pages.

Image Shift settings are not available from inside Mixed Media.
Image Shift is not supported for Booklet Maker and Gang-up printing.

For more information, see printer driver help.

Mail making

The Mail making print option, when selected, allows you to use the print to mail feature by printing envelopes and
documents for mailing at the same time.

The Wrapping envelope finisher must be installed to use the print to mail feature.

For information about finishers and other installable options, see printer driver help.

Mail making: Mail form

The Mail form print option lets you select the envelope paper size for the print job.

The Mail making print option must be selected to use this option.

Mail making: Mail form tray

The Mail form tray print option lets you select the tray with the envelope paper size for the print job.

The Mail making print option must be selected to use this option.
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Mail making: Duplex print (Mail form)

The Duplex print (Mail form) print option allows you to print on both sides of the envelope.

Select Off for single-sided printing.
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Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed content.

The Mail making print option must be selected to use this option.

Mail making: Enclose

The Enclose print option specifies whether any sheets need to be inserted inside the envelope.

The Mail making print option must be selected to use this option.

Mail making: Paper size (enclosures)

The Paper size (enclosures) print option lets you select the envelope sheet size.

The Mail making print option must be selected to use this option.

Mail making: Duplex print (enclosures)

The Duplex print (enclosures) print option allows you to print on both sides of the envelope insert sheet.

Select Off for single-sided printing.

Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed content.

The Mail making print option must be selected to use this option.

Mail making: Enclosures tray

The Enclosures tray print option allows you to select the envelope insert sheet tray.

The Mail making print option must be selected to use this option.

Mail making: Paper type (enclosures)

The Paper type (enclosures) print option allows you select the envelope insert sheet type.

The Mail making print option must be selected to use this option.

Mail making: Rotate enclosures 180 degrees

The Rotate enclosures 180 degrees print option allows you rotate the envelope insert sheet 180 degrees.

The Mail making print option must be selected to use this option.
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Pad Printing: Enable pad printing

Select the Enable pad printing check box to print pads.
Pad is a collection of a single or multiple page job with multiple copies.

For more information, see Pad printing on page 124.

Pad Printing: Add pad back cover

Select the Add pad back cover check box to add a back cover at the end of the pad.

Pad Printing: Back cover paper source

Specify the paper source tray to use for the pad back cover.

Pad Printing: Job copies per pad

Specify the number of pad copies to print.

Punch

The Punch print option allows you to specify the number of holes to punch for your job.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver help.

For more information, see Punch position and hole punching on page 126.

Punch: Punch edge

The Punch edge print option allows you to specify the location of punched holes.
To use this option, you must install a finisher with hole punching functionality.

For information about installing finishers and other installable options, see printer driver help.

Slip sheet

106

The Slip sheet print option, when turned on, allows you to insert a blank or preprinted sheet as a separator between

copies of a job with a large number of pages based on user configuration.

A slip sheet offset can be specified. Slip sheets are never stapled with the job.

Slip sheets can be inserted before every copy, sheet or set by selecting one of the following settings:
o Copies - inserts a sheet before every N copies of a job

¢ Sheets - inserts a sheet before every N sheets.

¢ Sets - inserts a sheet before every N VDP records, subsets, chapters, or uncollated copies, for example 10 copies

of page 1, of a job.
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Note: Slip sheets for Copies are not supported for uncollated jobs.

Slip sheet: Slip sheet media

The Slip sheet media print option allows you to use the same media defined for the job or a custom media size for
the slip sheet.

The Slip sheet media can be configured using one of the following settings:

e Same as job — uses the same media as the body of the job

¢ Custom — allows you to select a specific media size.

Stapler mode

The Stapler mode print option allows you to specify the number of staples and their positions.
Staple positions vary according to paper size, paper type, number of pages, and feed direction.

To use this option, you must install a finisher with stapling functionality.

Use set page device output bin tray mapping

Select to turn on Use set page device output bin tray mapping to allow the FS2000C to map the Output tray on a
job-level basis.

The Set Page Device (SPD) feature must be turned on in Configure. (See Command WorkStation Help.)

This option is only accessible from Command WorkStation Job Properties.

Variable Data Printing (VDP) options

The VDP tab shows all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings.

The FS2000C is compatible with the following variable data printing languages:

o FreeForm and FreeForm 2

Portable Document Format/Variable Transactional (PDF/VT)

e DPersonalized Print Markup Language (PPML)

e Creo Variable Print Specification (VPS)

For more information about VDP languages, see Variable Data Printing.

VDP documents using FreeForm must have the following settings for the master document and variable document
match:

¢ Color mode
o Combine separations
e Duplex

e Orientation
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e Document size

o Stapler mode
The following setting for the variable document overrides the corresponding settings in the master document:

e Media type

e Paper source

Cache PDF and PS objects

The Cache PDF and PS objects print option, when selected, recognizes objects (text, images, vectors) within a
PostScript or PDF file. PDF objects must be tagged as XObjects and PS objects must be in PS form to be cached,
which reduces the need to re-process image data for faster printing.

This option is only accessible from Command WorkStation Job Properties.

For more information, see Variable Data Printing.

Create master

To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.
Command WorkStation allows you to select up to 100 FreeForm masters.

For more information, see Variable Data Printing.

Enable enhanced FreeForm

Select to turn on Enable enhanced FreeForm to allow the mapping of select pages from the FreeForm master file in
the desired order and merge with the variable file when the job is processed.

You cannot apply FreeForm settings to an imposed job.

For more information, see Variable Data Printing.

File search path
Some PPML and other types of jobs do not contain all of the variable data job resources in a single file. In these cases,

on a job per job basis, specify the location of the variable data job external resources so that the FS2000C can access
them.

For more information, see Variable Data Printing.

Form: Form on top

The Form on top print option allows you to keep the form on top of the print job.
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Preview Master

Click Preview Master to generate a low-resolution image of your master page.

This option is not available for the Mac OS X v10.7 or later printer drivers.

Print master

The Print Master print option, when selected, allows you to verify or confirm your Master page.
Select Printer’s default to use the setting specified in FS2000C Setup.

For more information, see Variable Data Printing.

Remove white PPT background

Select to turn on Remove white PPT background when using Microsoft Office PowerPoint to create variable data in
conjunction with FreeForm.

This option removes the white background from PowerPoint files.

Use master

For variable data print jobs, specify a FreeForm master number to be used for the job.
Command WorkStation allows you to select up to 100 FreeForm masters.

For more information, see Variable Data Printing.

Define record length: Define record length

Process a PDF or PostScript file like a variable data print job, and apply record-based finishing.
This option is used in connection with the Pages Per Record option.

For more information, see Variable Data Printing.

Define record length: Pages per record

Define record-based (rather than job-based) finishing, based on the number entered.
This option is used with the Define Record Length option.

For more information, see Variable Data Printing.

Stamping (Watermark) options

The Stamping tab shows all image stamping options that add or hide/remove any image on the job.

This also includes watermark properties that define the placement and style of the watermark. For information, see
printer driver help.
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Copy numbering

The Copy numbering print option, when select, prints the job with copy numbering.

Copy numbering angle

The Copy numbering angle print option allows you to set the angle of the copy number printed for the print job.

Copy numbering font size

The Copy numbering font size print option allows you to select the font size for the copy number used for the print
job.

Copy initial number

The Copy initial number print option allows you to set the starting copy number for the print job.

Copy numbering transparency

The Copy numbering transparency print option allows you to print the copy number on each transparency.

Watermark

The Watermark print option allows you to select standard text for your watermark from the pull-down menu.
To create your own watermark, click New.

To modify a standard watermark, select it from the pull-down menu and click Edit.

To remove a watermark from the list, select it from the pull-down menu and click Delete.

For more information about using watermarks, see printer driver help.

Note: For Windows, do not select these fonts: AdobeSansMM and AdobeSerifMM.

Print Watermarks: First Page Only

The First Page Only print option check box, when selected, to specify how to print the watermark for the print job.
Select to turn on First Page Only to print a watermark only on the first page.

For more information about using watermarks, see printer driver help.

Override print option settings in Job Properties

Print option settings that were specified in the printer driver can be overridden in Command WorkStation Job
Properties.

1 In Command WorkStation, right-click a held job in the Job Center view.

2 Select Properties.



3 Specify the print option settings, and then click Print.

Exceptions to overriding print option settings in Job Properties
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You can override most print options in the printer driver and Command WorkStation Job Properties.

The exceptions are listed in the table.

Printer driver tab Option Driver Win | Driver Mac | CWS
Job Info Destination X

Print Range X

Print queue action X X

User Authentication: User name X X

User Authentication: Password X X

User Authentication: Use Windows Login X

User Authentication: I'm a Guest X
Media Document size X

Use set page device media mapping X
Layout: Normal Mirror X X

Orientation X

Orientation override X
Color Optimize RGB transparency X
Color: Expert Settings PDF/X output intent X
Finishing Use set page device output bin tray mapping X
Variable Data Printing (VDP) | Cache PDF and PS objects X
Stamping (Watermark) Watermarks X X

Print Watermarks: First Page Only X X
All tabs Adobe PDF Print Engine Preferred X

1
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Booklet Maker layouts in the printer driver and Command WorkStation Job Properties

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet format, without the need
for more involved page imposition programs.

Booklet Maker provides advanced settings, while streamlining the booklet-making process by displaying only the
options and controls relevant to your selections. Booklet Maker is capable of imposing jobs from nearly any
application.

Access Booklet Maker in the printer driver when you print a job, or in Command WorkStation Job Properties.

Note: Mixed Media jobs and variable data printing jobs are not supported by Booklet Maker.

The following booklet layouts are available:

Saddle binding: Signatures are folded together as a group, and then stapled or stitched along the center fold,
which forms the spine of the booklet.

1 Saddle (left) binding
2 Saddle (right) binding
3 Saddle (top) binding

Nested Saddle binding: Combines saddle and perfect binding methods by stacking two or more saddles (also
called “groups” or “subsets”) together along the common fold, then gluing them together at the fold to form the
spine.

[ R
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1 Nested Saddle (left) binding
2 Nested Saddle (right) binding
3 Nested Saddle (top) binding

Perfect binding: Separate, folded pages are printed and stacked in booklet order. Finished pages are stitched
adjacent to one another for trimming or gluing.
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1 Perfect booklet
2 Front(2,3,6,7)and Back (4, 1,8, 5)

For more information, see Booklet Maker Help.

For more information, see Booklet options in the printer driver and Job Properties on page 84.

Booklet Maker in the printer driver and Command WorkStation Job Properties

You can access Booklet Maker from the Layout tab in the printer driver and Command WorkStation Job Properties
when you print a job.

You can work with Booklet Maker as follows:

¢ Using the Booklet Maker wizard.
Recommended for first-time or novice users.
o Specifying settings in the main Booklet pane.

Recommended for experienced or advanced users.

For more information, see Booklet options in the printer driver and Job Properties on page 84.

Access Booklet Maker from the Windows printer driver

1 Inyour application, select File > Print.
2 Select the FS2000C as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Booklet option.

For more information, see Booklet Maker Help.

Access Booklet Maker from the Mac OS X printer driver

1 Inyour application, select File > Print.
2 Select the FS2000C as your printer, and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.
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4 In the printer driver, click the Layout icon and select the Booklet option.

For more information, see Booklet Maker Help.

Access Booklet Maker from Command WorkStation

1 Double-click your print job in the Held or Printed list, or right-click the job and select Properties.
2 Click the Layout icon in the Job Properties window.
3 Select the Booklet option.

4 Specify the Booklet Maker settings or click Launch Wizard to specify the settings graphically.

For more information, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper.

When imposed sheets are folded together as signatures, the pages follow in sequential, or reading, order. Booklet
Maker is designed for 2-up imposition, which imposes four individual pages from your document on a single sheet
that is printed duplex.

The printer is equipped with an advanced finisher, that also allows 1-up Perfect binding. (See 1-up Perfect Binding
Booklet options on page 87.)

The order in which pages are imposed is determined by the binding method that you select.

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if turned on.

You can open a job with Booklet Maker settings in Impose to preview the imposition layout or further modify the
imposition layout, if necessary.

Impose translates and maps all Booklet Maker settings to Impose commands.

Note: When a job with Booklet Maker settings has been edited in the Impose window, the job can no longer be
edited in Booklet Maker. Impose offers more settings that cannot be mapped to Booklet Maker settings.

For more information about Impose, see Utilities.

Create a booklet with the booklet options in the printer driver or Job Properties

Booklet Maker dynamically displays all of the controls applicable to creating a booklet in the main Booklet Maker
window.

1 Select a Booklet Type: Saddle, Nested Saddle, or Perfect.

If your printer supports 1-up Perfect booklets, select 1-up Perfect for the Booklet Type. For more information, see
Booklet Maker: 1-up Perfect binding printing on page 117.
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Select a binding edge: Left, Top, or Right.

Specify a Paper size.

Select Shrink to fit, if required.

Specify Page alignment.

Specify Creep compensation, if required.

Creep compensation is available for saddle and nested saddle booklets.

Specify cover settings, if you selected a saddle booklet.

Note: Cover settings are only available for saddle booklets. (See Adding a cover to a Saddle booklet on page 115).

Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Create a booklet with the Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the steps in the booklet-
making process.

1

2
3
4

Click Launch Wizard.
Specify the Booklet Type (binding method) and binding edge.
If Saddle was selected for Booklet Type, specify cover and content settings, and then click Next.

Specify paper size and media settings, and then click Next.
If Saddle was selected for Booklet Type, specify the paper settings for the cover, and then click Next.

If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.

Specify layout settings, and then click Next.

If Saddle or Nested Saddle was selected for Booklet Type, specify creep compensation.
View the settings summary.

Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover to a Saddle booklet

You can add covers (optional) for Saddle booklets.

Add a pre-printed cover to a Saddle booklet

1
2
3

In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.
Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

Select Pre-Printed from the Cover Content input menu.



4

5

Printing 116
Print Options

Click Define Cover and specify the cover media settings.

Click OK.

Add an inline cover to a Saddle booklet

-—
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In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.
Specify the required settings for Paper Size and Page Alignment for the body of the booklet.
Select Front & Back Separately from the Cover Content input menu.

Specify the Front cover and Back cover settings.

Click Define Cover and specify the cover media settings.

Click OK.

Note: When you print an inline cover with top-edge binding, the outside back cover automatically rotates 180
degrees to match the orientation of the front cover.

Booklet Maker cover options for Saddle booklets

For Saddle only, Booklet Maker includes two cover options: pre-printed or inline, for which you can specify media.

You can specify additional options for an inline cover by specifying the following cover options:

Content input: Select from Front & Back Separately or Pre-Printed.

Front & Back Separately: Select this option to specify an inline cover that prints the cover pages and body pages as

a single job. Separate pages from your document are imposed on a single sheet that forms the cover pages of your
booklet.

You can specify an inline cover when your original document includes the cover pages and/or cover artwork for
your booklet. The cover content may be the first and last pages of your document, or the first two and last two
pages of your document, or any combination.

If you select this option, you can specify the Front cover and Back cover options.

Pre-Printed: Select this option to insert a pre-printed cover that will be merged with the body pages of your
booklet, which print separately.

If you select this option, the Front cover and Back cover options are disabled.

Front cover and Back cover: These options allow you to quickly decide whether your front and back covers print
duplex, single-sided, or both sides blank, without needing to add blank pages in your original document.

With top-edge binding that includes a cover, the outside of the back cover automatically rotates 180 degrees to
match the orientation of the front cover.

Define Cover: This option allows you to select cover media settings for your cover pages, which may be trimmed.
This option is available for both pre-printed and inline covers.
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Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct connection. Booklet Maker print jobs must be sent to the
Print queue or Hold queue.

Set measurement units in Command WorkStation

You can change the default unit of measurement for all input fields in the Command WorkStation Preferences
dialog box.

Units specifies the units of measurement used to display attributes, such as page sizes and custom sizes, that you
enter in the Job Properties dialog box. This setting does not affect predefined page-size values.

1 In Command WorkStation, select Edit > Preferences.
2 Click Regional Settings.
3 Select the unit of measurement (millimeters, points, or inches).

4 Click OK.

The changes are not effective until Command WorkStation is restarted.

Booklet Maker: 1-up Perfect binding printing

The 1-up Perfect binding method prints single body pages that are stacked together, so that the edges may be
trimmed (if desired) and glued, and then wrapped by a cover sheet.

You can access the 1-up Perfect binding method from the printer driver or Command WorkStation Job Properties.

Note: If the printer is equipped with an advanced finisher, such as a Perfect binder, the option of 1-up Perfect
binding may be available.

Note: Do not print anything on the inner side of the cover sheet (the area glued to the book block). Doing so can
prevent the cover sheet and book block from adhering properly.

To print a 1-up Perfect booklet, you must select 1-up Perfect as the booklet type.

For more information, see 1-up Perfect Binding Booklet options on page 87.
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Defining and printing custom page sizes
With custom page sizes, you define the dimensions of a printed page. After you define a custom page size, you can
use it from within an application without redefining it each time you print.

When you create custom page sizes, specify width dimensions to correspond with the shorter side of your job and
specify height dimensions to correspond with the longer side of your job. Set custom page sizes in this way,
regardless of the orientation settings in the application.

@ @

@

1 Portrait orientation
2 Landscape orientation
3 Height

4 Width

Note: Custom page sizes are not supported with Imposition jobs.

For information about defining and printing custom page sizes, see printer driver help.

Document size and Paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box.

Paper size is the size of the actual sheet of paper on which your job is printed. It may be useful to think of Document
size as digital input (the page size defined in your original document) and Paper size as the physical output (the
actual size of the paper in the printer tray).

In cases when you print one document page per sheet of paper, Document size is usually the same as the Paper size.
However, Document size may differ from Paper size when you print booklets or impose multiple document pages on
a single sheet.
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The illustrations show examples of possible relationships between Document size and Paper size. Note that the
orientation of all pages shown is landscape.

Description Document size (input) | Paper size (output)
Document size is the same as Paper size. Scaling is 100%. Letter Letter

Tabloid Document size scaled to fit on Letter Paper size. Scaling is 50%. | Tabloid 11x17 Letter
A4 Document size scaled to fit on A3 Paper size. Scaling is 141%. Ad A3

Document size may also differ from Paper size when using the Scale or Scale to fit options. The Scale option reduces
or enlarges the document page at a specified percent. The Scale to fit option automatically reduces or enlarges the
document image to fit the selected paper size.

For information about Document size and Paper size in booklet printing, see Booklet Maker Help.

For more information, see Scale on page 82.

Fiery VUE annotations

The Fiery VUE application is a 3-D layout tool that allows you to specify the layout of documents. You will see
thumbnails of the actual pages to create a picture of the final output.

For more information, see Fiery VUE Help.

The Annotations feature allows you to add annotations to each page of your document.
1 Start Fiery VUE either as a standalone application or from the Microsoft Office application.
2 In Fiery VUE, go to Insert > Annotations.
3 Inthe Annotations window that appears, type your annotation in the appropriate field.
4 Select one of the available options:
¢ Page Numbering to add page numbers to each page in the document.
¢ Include Page Count to include the total page count on each page in the document.

¢ Do not print on first page to print annotations starting on the second page of the document.



5 Select a font and font color.

6 Click Save to preview your annotation in Fiery VUE.

Fold style options

The Fold style specifies how the folded job is printed.

You can specify whether the pages of your folded job print with the imageable area on the inside or outside of the

folded sheet.

The following types of folds are supported:

Fold style Fold illustration
2-fold

\
Booklet fold

X

\\
Inner 3 fold
Outer 3 fold
Z-fold

A finisher capable of folding must be installed on the printer.
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Note: When you select a folding option, Output delivery is automatically set to the correct setting. It is not possible

to print folded jobs face up or in reverse order. The Fold order option allows you to specify whether text/images
print on the inside or outside of the folded sheet.

For information about finishers and other installable options, see printer driver help.
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Gang-up printing

Gangup layout options are used for speed printing imposition modes.

The FS2000C includes two speed-printing options for gang-up printing:

e Step &repeat - Select this option to speed print a job so that the first page of your document is printed twice on
the first sheet. The next sheet duplicates the data on the second page, the next sheet duplicates the data on the
third page, and so on. When the printed sheets are cut in half, the result is two complete sets of the same
document.

2,2 3, 3 4 | 4
i i 5
| |
| |

@ ®

1 Single-sided, front only
2 Duplex (double-sided), front (1, 3) and back (2, 4)
e Cut &stack - Select this option to speed print a job so that when the sheets are stacked and cut from the central

position, the job is numbered in order and separated as two stacks. The print order is such that when the sheets
are cut in half, you can combine them to form a single complete set of the document, in faster printing time.

2 | 4 3, 7 4 | 8
T T |

@ @

1 Single-sided, front only
2 Duplex (double-sided), front (1, 3, 5, 7) and back (2, 4, 6, 8)

For more information, see Gangup layout options on page 83.

Access Gang-up print from the Windows printer driver

1 In your application, select File > Print.
2 Select the FS2000C as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Gangup option.
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Access Gang-up print from the Mac OS X printer driver

—

In your application, select File > Print.

2 Select the FS2000C as your printer and select Fiery Features from the drop-down list.
3 Click Full Properties in the Quick Access pane.
4

In the printer driver, click the Layout icon and select the Gangup option.

Image Enhance

The Image Enhance feature lets you apply photo finishing enhancement to color images on specified pages or sheets
of a job. This feature affects only photographic images, not graphics such as logos or charts.

To turn on this feature, select the Apply image enhancement check box for a job and specify the pages or sheets to
be affected. This option is located in the Image tab of the printer drivers and Command WorkStation Job Properties.
You can customize Image Enhance settings from Command WorkStation.

For more information, see Command WorkStation Help.

Output delivery

Output delivery allows you to specify how the stack of copies is delivered in the output tray.

Do one of the following for single-side printing:

o Select Face up for sheets delivered into the output tray with copies facing up, with normal order for the first
sheet on the top of the stack, or reverse order for the first sheet on the bottom of the stack.

e Select Face down for sheets delivered into the output tray with copies facing down, with normal order for the
first sheet on the bottom of the stack, or reverse order for the first sheet on the top of the stack.
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1 Face up - normal order

2 Face up - reverse order
3 Face down - normal order

4 Face down - reverse order

Do one of the following for 2-sided (duplex) printing:

Select Face up for 2-sided sheets delivered into the output tray with copies facing up, with normal order for side
1 of the first sheet on the top of the stack, or reverse order for side 2 of the first sheet on the bottom of the stack.

Select Face down for 2-sided sheets delivered into the output tray with copies facing down, with normal order
for side 2 of the last sheet on the top of the stack, or reverse order for side 1 of the last sheet on the bottom of the
stack.
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1 Face up - normal order
2 Face up - reverse order
3 Face down - normal order

4 Face down - reverse order

Note: When using a finisher that reverses the order of the stack, you can specify normal order so that when the stack
is fed through the finisher, the pages are delivered in the correct order.

Pad printing

Pad printing gives you control over printing multiple copies of a job without having to perform unnecessary mental
calculations or requiring multiple steps every time.

With the Pad printing print options on the Finishing tab of the printer driver or Command WorkStation Job
Properties, you can specify pad-printing parameters. You can define the contents of each pad, including the number
of times the job repeats within a pad.

It duplicates a single job as many times as defined in the Pad printing settings to create one finished or merged pad.
You can add a back cover.

Pad printing also allows you to simply assemble printed pads with a back cover, similar to sticky notes. When cover
has been turned on for pad printing, the page size and orientation of the cover media should be the same as the main
job.

You can use the Job copies per pad print option to specify the number of pads in the job. Pad copy packs are offset in
the output tray for easy separation for offline binding.

An example of a job printed with the Pad printing settings.



1 Each sheet of each pad is printed duplex (double-sided) and repeated 25 times.

2 Aback cover is added.

Print Duplex (double-sided) pages

1 Inyour application, do one of the following:
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¢ On Mac OS X computers: Select File > Print, select the FS2000C as your printer, select Fiery Features from the

drop-down list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

¢ On Windows computers: Select File > Print, select the FS2000C as your printer, click Properties, and then click

the Layout icon.

2 Select one of the Duplex settings:

¢ Top-top: Prints the top of the image on Side 1 on the same edge of the page as the top of the image on Side 2.

¢ Top-bottom: Prints the top of the image on Side 1 on the opposite edge of the page from the top of the image

on Side 2.
Orientation | Top-top Top-bottom
oW OO o BN [4
A A A
\Y
Portrait 1 2 1 oo
o N o O o n 4
A A
Landscape 1 2 1 go

3 Print the job.
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Punch position and hole punching

You can specify the number of holes to punch and the location of the punched holes.

A finisher capable of punching must be installed on the printer.

Note: Punch positions vary according to paper size, paper type, number of pages, feed direction, and original
orientation.

126

Note: Punch can only occur on the lead or trail edge of the paper. The paper orientation may need be changed in the

printer to accommodate all of the punch configurations.

Punch Portrait: Left | Portrait: Right | Portrait: Top | Landscape: Left | Landscape: Landscape: Top

setting Right

2 holes o oo ° o 6 o
‘R R R - R R. R

o

3 holes o ° coo ° 600
‘R R R °R R
o o

4 holes ° ° 0000 ° ° 0000
:R R: R :R R§
o o

For information about finishers and other installable options, see printer driver help.

User Authentication

If Users and Groups user authentication is configured in FS2000C Setup, you must enter a valid user name and
password to send a print job to the FS2000C.

In Command WorkStation, the management of jobs is determined by how you log on to the FS2000C.

The print options associated with Users and Groups user authentication are as follows:

e On Mac OS X computers: Select the Job Info icon and type logon information in the User name and Password

fields.

e On Windows computers: Set the following:

e Use Windows Login - Select this option if you are already logged on to a Windows computer. Otherwise, type

your Windows network logon information in the User name and Password fields.

e Validate - Click to validate user authorization and to confirm printing privileges. To validate, Two-Way

Communication must be turned on. For information on establishing Two-Way Communication, see printer

driver help.

e I'ma guest - Select this option to activate guest printing privileges. By default, guest printing is turned on.

For information about turning on Users and Groups user authentication in Configure, see Configuration and Setup

and Command WorkStation Help.
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Supplemental printing information

This section supplements the documentation for your printer and print server to correct and clarify the information
that appears in those documents.

Keep the following in mind when using the ComColorExpress FS2000C.

e The FS2000C does not have Japanese fonts.

If font errors are printed, verify the font settings after the printer driver is installed.

1 Right-click the printer in the Devices and Printers Control Panel and then display the ComColorExpress
FS2000C Printing preferences window.

2 On the PostScript tab, set True Type Font Setting to Download as Softfont.
3 Click Apply.

Note: Please make sure the Japanese fonts are installed before printing Japanese specific test files.
¢ While receiving a job, Fiery Ticker's Remaining time display is not accurate.
¢ When scanning with the FS2000C and the scan size is set to Automatic, please use short edge feed direction.

If the scan size is set to Automatic and you want to scan with paper in the long edge feed direction, then
interchange the Portrait and Landscape settings in Orientation on the Scan window.

e For Mac OS, it takes about 10 minutes to acquire printer driver information, such as Paper Catalog information,
ink information and master used.

o Fiery's barcode processing implementation is such that; barcode processing will be done for text, graphics, and
images on the entire source document, not specific to the barcode area in the source document. Due to this, it is
likely that erosion can occur for text, graphics, and images outside the barcode area, which may result in thin
lines and/or text in the source being removed if barcode processing is turned on.

¢ For Mac OS, do not change the orientation of the Adobe Reader Print window from Automatic portrait /
landscape.

When printing a landscape document as a perfect booklet job with top binding, the Orientation option needs to
be set as Landscape on the Page Setup window.

How to determine the print position adjustment for 1-up Perfect Right binding
1 Measure the thickness of the body in advance and obtain the width of the spine.
2 The print position adjustment value is calculated by the following equation:
Cover Position adjustment horizontally = Cover Paper Size - [(Body Paper Size)x2 + Spine width]

3 Add a negative sign to the obtained print position adjustment value and type the value in the Cover Position
adjustment horizontally setting for 1-up Perfect Right binding booklet on the Layout tab in the printer driver.
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